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Communications regulation information

FCC statement

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. Seeinstructionsif interference to
radio or television reception is suspected.

Radio and television interference

The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If itisnot installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception.

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specificationsin Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in aresidential installation. However,
there is no guarantee that interference will not occur in a particular installation.

Y ou can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices.

If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures:

= Turnthetelevision or radio antenna until the interference stops.

= Movethe computer to one side or the other of the television or radio.

= Movethe computer farther away from the television or radio.

= Plug the computer into an outlet that is on adifferent circuit from the television or radio.

(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.)

If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions.

IMPORTANT Changes or modificationsto this product not authorized by Apple Computer, Inc.,
could void the FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple
peripheral devices and Apple shielded cables and connectors between system components. It is
important that you use Apple peripheral devices and shielded cables and connectors between
system components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices. Y ou can obtain Apple peripheral devices and the proper shielded
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices,
contact the manufacturer or dealer for assistance.

Communications Regulation Information



DOC statement

DOC Class B Compliance Thisdigital apparatus does not exceed the Class B limits for radio
noise emissions from digital apparatus as set out in the interference-causing equipment standard
entitled “Digital Apparatus,” ICES-003 of the Department of Communications.

Observation des normes—Classe B Cet appareil numérique respecte les limites de bruits
radioél ectriques applicables aux appareils numériques de Classe B prescrites dans lanorme
sur le matériel brouilleur: “Appareils Numériques’, NMB-003 édictée par le ministre des

Communications.

VCCI statement

ERAERBEEREEBERMICOVT

ORI, BTRENEER (eI F OB L 2 i sy Tl
MENBNEMEHER) ol coBEREN L2 HME L 22NHRe
AL AR B P R B AR S (vean) EEILEA LT £,
L, KEB UL, FLE Yz v SABIOEEL CIMII RS &,
TREEEOENE LI ENHY T,

BURSWIE I H > CIEL VIR DIV E LT S0,

Communications Regulation Information

vii



Welcome

Congratulations on your purchase of the Color StyleWriter 2500 printer. This
book describes how to set up the printer and how to use it.

Main features of the Color StyleWriter 2500

The Color StyleWriter 2500 works with most Macintosh computers, including
computers using QuickDraw GX.

The Color StyleWriter 2500 quietly prints high-quality color graphics and
text on a variety of materials, including plain paper.

An energy conservation feature turns off the printer when you arerit using
it and turnsit on when needed.

The automatic sheet feeder holds up to 100 sheets of paper or up to 15
envelopes

Desktop printing makes it easy to switch printers and monitor your print
requests.

ColorShare (installed with the printer software) allows you to share the
printer with anyone on your AppleTalk network (including people using
Local Talk, EtherTalk, or TokenTalk).

64 available TrueType (outline) fonts print smoothly in a variety of sizes



Changes to the printing software that affect other printers

If you have another printer that uses Applés PrintMonitor application
program, including all LaserWriter and all StyleWriter printers, please note
the following changes:

= Your new printing software includes a feature called desktop printing,
which gives you new ways to print from the desktop. For details, see
“Desktop Printing” in the “Printing a Document” section in Chapter 2.

= You also use the desktop printing features (instead of Applés PrintMonitor
program) to monitor background printing. See “Monitoring and
Controlling Background Printing” in Chapter 2.

System requirements
To install the printer software and use the Color StyleWriter 2500 printer with
your Macintosh computer, you need

» aMacintosh with a 68020 or higher central processing unit (CPU),
any Macintosh except a Macintosh Plus, SE, Classic®, Portable, or
PowerBook 100

= Macintosh Operating System (Mac OS) version 71 or alater version

» at least 4 megabytes of random-access memory (RAM) 5 megabytesis
recommended

» Some space available on your hard disk (during installation the I nstaller
tellsyou if you need more disk space)

The Installer program that comes with the Color StyleWriter 2500
automatically checks whether your computer meets these requirements.
Chapter 1 explains how to use the Installer program.

Welcome



Setting Up Your Printer

This chapter introduces the Apple Color StyleWriter 2500 printer and
explains how to set it up. After you follow the instructionsin this chapter,
you Il be ready to print.

Before you begin Make sure that your computer is already set up and that you
know the basics of its operation.

Important safety instructions

Always take the following precautions:

Keep the printer cover closed when printing.
Always turn off the printer before unplugging it.
Keep the ink tanks and ink cartridges away from children.

Keep the printer away from sources of liquid, such as wash basins,
bathtubs, and shower stalls

Protect the printer from dampness or wet weather, such as rain and snow.

Read all the installation instructions carefully before you plug the printer
into awall socket.

Keep these instructions handy for reference by you and others.
Follow all instructions and warnings dealing with your computer system.



2

Chapter 1

Dot use devices that produce open flames, such as Bunsen burners, near
the printer.

Dorit use alcohol-based or ammonia-based cleaners on or around the
printer.

Always unplug the printer before cleaning it. (Use only the cleaning
procedure recommended in Chapter 4)

Clean the outside of the printer with only a damp cloth and, if necessary, a
mild soap or detergent. Be careful not to get liquid into the printer or the
power cord receptacle

IMPORTANT The only way to disconnect power completely is to unplug the
power cord. Make sure at least one end of the power cord is within easy reach
so that you can unplug the Color StyleWriter 2500 when you need to.

Watch for these situations, and if one occurs pull the plug!

the power cord or plug becomes frayed or otherwise damaged
you spill something into the printer

the printer is exposed to rain or any other excess moisture
the printer has been dropped or otherwise damaged

you suspect that your printer needs service or repair

WARNING Electrical equipment may be hazardous if misused. Operation
of this product, or similar products, must always be supervised by an
adult. Do not allow children access to the interior of any electrical
product and do not permit them to handle any cables



Unpacking the printer

1 Remove everything from the shipping box, but leave the ink cartridge in its package.

Be sure to remove packing
material from the sheet feeder.

Be sure to open the printer's
cover and remove the packing
tape from inside.

Color StyleWriter 2500
Ink cartridge
(Leaveitinthe Storage case
plastic tub for now.) for ink cartridges

Power adapter

2 Remove the tape and packing material from the inside and outside of the printer.

Save the carton and the packing material in case you ever need to ship the
printer. (See Appendix G, “Packing and Moving the Printer.”)

3 Close the printer's cover.

Setting Up Your Printer
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Place the printer in your work area.

Choose alocation near your computer that has a grounded electrical outlet
and good ventilation, is out of direct sunlight, never gets damp or very hot or
very cold, and is awvay from devices that could cause el ectromagnetic
interference, such as stereo speakers or cordless telephone transmitters. Do
not place the printer on a danted surface See Appendix A, “Technical
Information,” for specific information about the physical requirements of your
printer.

IMPORTANT Dorit accidentally discard the ink cartridge storage case You heed
it to store an opened cartridge that youre not using in the printer. The case
keeps the print head from drying out and prevents accidents with ink stains.

If you print only afew color images, and most of your printing isin black,
you can purchase a high-performance black ink cartridge and use it as an
alternative to the color ink cartridge When either cartridge is not in the
printer, keep the cartridge in the storage case

You can use the same ink cartridge in both a Color StyleWriter 2400 and a
Color StyleWriter 2500.

Power Macintosh users and Virtual Memory

Chapter 1

If you are using a Power Macintosh computer, be sure to turn on Virtual
Memory before you try to print on the Color StyleWriter 2500. Then choose a
setting that's at least 1 MB higher than your “Available built-in memory.” (You
can set it higher without any ill effects) With this setting, you will avoid some
potential printing problems. Turning on Virtual Memory also reduces the
amount of memory needed by many applications. For instructions on turning
on Virtual Memory, see the documentation that came with your computer.



Plugging in the printer

Plug the connector end of the power adapter into the printer and then plug the
other end of the adapter into an outlet.

IMPORTANT The only way to disconnect power completely is to unplug the
power cord. Make sure that at |east one end of the power cord is within easy
reach so that you can unplug the printer in an emergency.

Setting Up Your Printer
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Turning the printer on and off

To turn the printer on (and off), press this button.

This light blinks.

This light glows
while the printer is on.

The first time you turn on the printer, the green power light glows and the
yellow error light blinks because you havenit installed an ink cartridge yet.

Saving energy

To save power, the printer turnsitself off after sitting unused for about 5
minutes. Aslong as you leave it plugged into an active power outlet, the
printer turnsitself on automatically when you print something.

WARNING Except in an emergency, make sure the printer is turned off
before you unplug it. (When the power light is off, the power is off) If
the printer is plugged into a power strip, never turn off the power strip
unless youve aready turned the printer off.

Each time you turn off the printer, or the printer turns itself off, it
automatically moves the ink cartridge to the right, where it caps the
nozzles to keep the ink cartridges from drying out. If you unplug the
printer or discontinue power before turning it off, the printer carit
position the cartridge in the capped position, the print head may dry out,
and you Il have to replace the cartridge

6 ' Chapter 1



Installing the ink cartridge

Theink cartridge contains the print head, which sprays the ink onto the
paper. Treat it gently so you don't damage its tiny nozzles.

WARNING The carrier holds the ink cartridge and moves it back and
forth when you are printing a document. When the printer is plugged in,
donit dide the carrier by hand or you may damage the printer.

Before you start, make sure the printer is turned on. (The green light glows,
and the yellow light blinks)

1 Open the printer by pulling down its front cover.
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Raise the bright blue lever on the carrier.

Remove the cover from the plastic tub that contains the ink cartridge.

These instructions show the four-color cartridge being installed, but the
process is the same for either cartridge (You can buy a high-performance
black ink cartridge in addition to the color cartridge)

Grasp the ink cartridge by its sides and remove it from the plastic tub.

You may safely touch the black plastic, but be careful not to touch any other
part.

Remove the bright orange cap from the cartridge’s print head.

After you snap it off,
dispose of the cap.



6  Peel the orange tape off the print head.

Note: There are instructions inscribed inside the printer cover to remind you
how to install either the color or optional high-performance black ink
cartridge

Setting Up Your Printer ‘



8 Lower the bright blue lever on the carrier to secure the ink cartridge in place.

9  Close the printer’s front cover.

10 ' Chapter 1



Connecting the printer to your Macintosh

IMPORTANT Even if youre planning to share the printer over a network, the
serial cable must connect the printer directly to the computer. Use only the
cable that comes with the printer or asmilar replacement. Do not use a
Local Talk cable unless you purchased the Local Talk Option for this printer
(in which case you should see the instructions that came with the option).

Connect this cable to either the
printer port or the modem port,
which are labeled with these icons.

Some Macintosh computers have a
combined serial port with two icons.

If your computer is connected to a network, a network cable may aready be
connected to the printer port (&). In that case, use the modem port (%).

Remember which port you use Later you must tell the printer software where
to look for the printer.

Some PowerBook computers that have an internal modem installed cannot
tell that the printer is plugged in. You must change a setting in the PowerBook
Setup or Express Modem control panel. For details, see “Special I nformation
for PowerBook Owners’ in the section “Telling Your Computer to Use the
Color StyleWriter 2500;" later in this chapter.

Setting Up Your Printer ‘ 11
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Loading paper into the sheet feeder

E Chapter 1

3

The sheet feeder holds up to 100 sheets of 20-pound paper and feeds the
paper automatically into the printer. You can load many sizes of paper and
other media into the sheet feeder as described in Chapter 2, but to do a nozzle
check, as described in the next section, you must use U.S letter-size or A4
paper. To load paper into the sheet feeder, follow these steps:

Open the printer cover.

Adjust the internal paper selector.

Internal paper selector

Put the selector in
the center position.

Close the printer cover.



Load a stack of U.S. letter-size or A4 paper into the sheet feeder.

Instructions for loading paper correctly appear on the paper support.
Information on the back of the paper tray shows you where to set the guide
for different paper sizes.

Slide this guide so it just

touches the edge of the paper.

If the stack of paper bows out
even slightly, the guide is too tight.

Extend this paper support.
Make sure the paper extends
above the support (and doesn't
slide down inside the printer).

Make sure the paper lines up evenly
at this side of the feeder.

Do not stack paper above this line ().

Make sure the external paper selector
is next to the ¢ icon.

To open the output tray, pull here. Be sure to pull it out all the way.
If you're printing on legal-size paper, don't open the tray.

Setting Up Your Printer ‘ 13
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Installing your printer software

Chapter 1

Before you can print your documents, you need to install the printer software
on your Macintosh. The disks that come with the Color StyleWriter 2500
contain the printer software and an Installer program.

The Installer program installs the new printing software you need, plus any
fonts that come with the printer (see Appendix C for alist of available fonts).
If you use Apples special QuickDraw GX software, it will also install new
QuickDraw GX software for the Color StyleWriter 2500.

Note: If you ever upgrade your system software (for example, from System 71
to System 7.5), you must reinstall the Color StyleWriter 2500 software

Step-by-step installation instructions

These instructions tell you how to restart your computer with the extensions
turned off (which prevents incompatible software from interfering with the
installation) and how to use the Installer program.

Before you begin Lock all the disks by turning each one over and diding the
small, square plastic tab in the corner so you can see through the hole (The
disks may already be locked))

Quit any programs you are running.

While holding down the Shift key on the keyboard, choose Restart from the Special
menu. Don't release the Shift key until you see the “Extensions off” message on your
screen.

After you see the Macintosh desktop, insert Color StyleWriter 2500 Disk 1 into a floppy
disk drive.

To start the Installer program, double-click its icon.

You may have to open the disk icon to see the Installer icon.



Make sure the disk
named here is the
one on which you
want to install the

printer software.

(If not, click Switch

Disk until the correct
name appears.)

In the Welcome dialog box that appears, click Continue.

IMPORTANT The Installer determines whether you have the correct system
software, and enough memory and hard disk space to use this printer. If you
don't, the Installer displays a message telling you what you need. You worit be
able to install the printer software until you correct the system software or
memory problem. If the message reports a problem, you can purchase new
gystem software or memory from an Apple-authorized deal er, or make space
available on your hard disk by throwing away files you dorit need.

In the Installer dialog box, click Install.

Install Color SI) 2500 =—————F =

[ Easy Install v

Color StylelWriter 2500 Software

------ Destination Disk

Eiwnt ek When you’re ready to
Vour Hord sk (nstan )| begin, click Install.

[@

After afew moments, the Installer beginsto install the printer software A
status box keeps you informed of progress during installation.

When you see a message on your screen, follow the directions and insert the next disk.

The Installer gjects disks and asks you to insert others. Keep following the
instructions on the screen until the installation is complete

Setting Up Your Printer ‘ 15
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When you see a message reporting that installation was successful, click Restart.

The Installer restarts your computer. After you restart, you may notice on
your desktop, a hew icon that represents a printer. It's called a desktop printer,
and it looks like this. For information about desktop printers, see “ Desktop
Printing” in the sections “Printing a Document ” and “Monitoring and
Controlling Background Printing” in Chapter 2.

Examples of desktop printer icons

1
E (a bold outline indicates the

Color Stylewriter 2500  Laser'writer  Selected printer)

If thisisyour first printer, you worit see a desktop printer icon yet.

After the computer restarts, you must select the printer in the Chooser, as described in
the next major section, “Telling Your Computer to Use the Color StyleWriter 2500."

Installation troubleshooting

If the Installer can't complete the installation, it will issue a warning message
Here are some ways to fix common problems:

= You may not have the correct hardware or system software for this printer.
If so, the Installer will tell you what youre missing.

= You may have forgotten to turn off your software extensions as described in
the previous section.

= You may have some corrupted fonts on your hard disk. To solve this
problem, see “Installation Is Unsuccessful” in Chapter 5

More information about the Installer program

In the procedure just described the Installer copies all the software you need
to your hard disk. In rare circumstances you may want to copy only a subset
of the software. In that case choose Custom Install from the pop-up menuin
the Installer. When allist of choices appears, select the items you wish to
install, then dick the Install button. (Click the letter i to the right of any of
the choices for information)



Telling your computer to use the Color StyleWriter 2500

First, click this icon.
(If you don't see the
icon, use the scroll
bar and arrows

to find it.)

If your computer is
connected to a
network, the Chooser
may look different,
but you can still follow
these steps.

Before using your printer, you must select it in the Chooser.
Select Chooser from the Apple (6) menu.
In the Chooser dialog box, click the appropriate items to select them.

On most Macintosh computers, the Chooser looks like this:

[I=————"—— Chooser

TRt
[ ]

Connect to:

Printer Port .
ke md Pt Then click one of these

AppleShare

items to indicate which port

o e you connected the printer to:
Key hecess Lazeririter the printer port (E,) or the
modem port ().
Mackz5 If no port is available

|| and your computer is a

= o

, sctoroms Frmting PowerBook, see “Special

® On O 0Ff Information for PowerBook
Owners,” later in this chapter.

) Active
@ lnactive

AppleTalk

&l

Close the Chooser by clicking the close box in its upper-left corner.
Notice the new desktop printer icon for the Color StyleWriter 2500.

After you close the Chooser, a desktop printer icon for the Color StyleWriter
2500 appears on the desktop.

1 I |

Colar Stylew'riter 2500

This icon cannot be moved off the desktop (unless you throw it away);
however, you can place it anywhere on the desktop that you like

Setting Up Your Printer ‘ 17
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Special information for PowerBook owners

PowerBook computers that have internal modems may require special setups.
What you do depends on whether the Powerbook has one or two serial ports
on its back panel.

PowerBook computers with one serial port

Some PowerBook computers have a single serial port identified by a
combination printer/modem icon (&/%). If aninternal modem isinstalled on
one of these PowerBook computers, the serial port may be in use even though
it looks available When you plug in the Color StyleWriter 2500, the
PowerBook may not be able to communicate with the printer.

To make the port available for printing, make sure the serial port setting is
Normal or External. To check the setting, open the PowerBook, PowerBook
Setup, or Express Modem control panel. (If you have another kind of internal
modem, you may have a different control panel. The control panel and the
setting you use depend on which PowerBook you have and which internal
modem you have) If you have a PowerBook Express Modem, it is best to
leave the serial port setting as Normal or External unless the modem
programs you use require another setting for compatibility reasons

PowerBook computers with two serial ports

Even when a PowerBook has two serial ports, if it also has an internal
modem, the modem port (&) may look available but actually bein use If the
printer port (&) is available, connect the Color StyleWriter 2500 to it. If the
printer port is unavailable and you must use the modem port, make sure the
modem serial port setting is Normal or External. To check the setting, open
the PowerBook, PowerBook Setup, or Express Modem control pand. (If you
have another kind of internal modem, you may have a different control panel.
The contral panel and the setting you use depend on which modem and
system software version you have) If you have a PowerBook Express Modem,
it is best to leave the serial port setting as Normal or External.

For more information, see the instructions that came with your PowerBook.



Printing a document to make sure everything’s working

First, use this pop- —|

up menu to indicate
the size of the paper
loaded in the printer.

The best way to seeif your printer is set up correctly isto try printing
something. The following steps describe how to print the Color SW 2500-
Troubleshooting file that was installed on your hard disk, but you can print

any document you want.

Before you begin Return to the Finder by quitting any programs youre running.

Find the Color SW 2500-Troubleshooting file.

Unless you moved it, you can find the file by double-dicking your hard disk

icon.

Open the file by double-clicking its icon.

Calar 5% 2500-Troubleshoating

Choose the Page Setup command from the File menu.
A dialog box opens.

Indicate what paper size you're using.

Color Stylellriter 2500 Page Setup
Page Size: ~US Letter
Us Legat
Layout:|_| puecutive &
Scaling (% #10 Envelope
#6 Envelope
Orientatiol__fA4 Letter
QAT

| Then, click OK.

You dort need to choose the Page Setup command every time you print—you
only need to use it when you want to change the normal settings. Look at the
dialog box on your screen to note what the normal settings are For

information about the options in this dialog box, see “

Printing a Document”

and “Creating Special Effects on the Color StyleWriter 2500” in Chapter 2.

Setting Up Your Printer
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5
6

Choose the Print command from the File menu.

In the dialog box that appears, click the Print button.

Color StylelWriter 2500

Copies: EI Pages: @® All O From: I_I To: I_I
Print Quality: O Best (® Normal (O Draft
Image:[ Color ]
Notification:|_None  w|

Cancel

[[W]]_ | Click here.

After afew moments, the printer begins printing the page or pages. If therés a
problem, see Chapter 5 for suggestions. (The most common problem is failing
to follow the instructions in “ Telling Your Computer to Use the Color

StyleWriter 2500 earlier in this chapter)

For information about all the choices you can make in the Print dialog box,
see “Printing a Document” and “ Creating Special Effects on the Color

StyleWriter 2500” in Chapter 2.

Choose Quit from the File menu to leave the Color SW 2500-Troubleshooting file.



Checking the print nozzles

The Color StyleWriter 2500 prints by spraying ink onto the paper through
tiny nozzles. Sometimes these small nozzles get dogged after sitting unused

for along time To make sure all the nozzles are working, follow these steps:

1  If necessary, turn off the printer.
The green power light should be off.

2 Press and hold down the power button for about 5 seconds, until the yellow error light
goes out.

Press the power button.

When the yellow error
light goes out, release
the button.

3 Release the button and wait for the test page to print.

Setting Up Your Printer
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What's next?

Chapter 1

Examine the nozzle test pattern for broken or missing horizontal lines.

The nozzle test pattern appears near the bottom of the test page The test
pattern for the four-color ink cartridge looks like this:

A broken line means a nozzle on A missing color means you need to

the print head needs to be cleaned. replace an ink tank (or the black-only cartridge).
Yellow

Magenta —| : 3 : f |

Cyan

Back m— 11—+ — 07 —"F+F7-—"-+—1 | |

The test pattern for the optional black-only ink cartridge looks like this:

I o s o e S N T

If you see a broken line, one or more nozzles may be clogged. See the section “Cleaning
the Print Head” in Chapter 5.

Youre now ready to start using your printer.

= |If you want to share the printer with others on your network, see “Sharing
Your Printer With Other Users’ and “Printing on a Shared Color
StyleWriter 2500” in Chapter 2. If you purchased the Local Talk option for
this printer, see “ Connecting a Color StyleWriter 2500 to a Local Talk or
EtherTalk Network” in Chapter 2.

= |f you haveinstalled QuickDraw GX and turned it on, see Appendix E.



Printing

This chapter explains how to use the Color StyleWriter 2500 for everyday
tasks Before you follow the instructions in this chapter, make sure the printer
is set up and working, as described in Chapter 1

Note: If you use QuickDraw GX, not all of the instructionsin this chapter
will apply to your software. See Appendix E for more information.

Planning documents with the Color StyleWriter 2500 in mind

Many printer options affect how much can fit on a page Before you spend a
lot of time laying out a document, set it up as you plan to print it:

1  Select the printer you plan to use.
See “ Switching Between Printers,” later in this chapter.

2 With the document active on your computer screen, choose Page Setup from the File
menu and select the options you like.

The key areas that affect page layout are paper size, orientation, and scaling
percentage When youve finished setting your options, dick the OK button to
return to your document. You can now format it as you like Since youve
already set your printing options, the document will print as you see it on
your screen.
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Loading the sheet feeder

Chapter 2

The sheet feeder holds paper, envelopes, or other materials and feeds them
automatically into the printer. To load the sheet feeder, follow these steps:

Remove any paper or other materials that you don’t want to use.
Adjust the external paper selector, as shown in the next step.

It's important to adjust the selector before loading the new material into the
sheet feeder.

Load the paper or other materials.

IMPORTANT Dorit mix envelopes with paper in the feeder.

Extend this paper support.
Make sure the paper extends

above the support (and doesn't
slide down inside the printer).

Insert letterhead paper face up
with the top of the page pointing
downward.

Slide this guide so
it just touches the
edge of the paper.
If the stack of paper bows
out even slightly,

the guide is too tight.

Insert envelopes this way.
(Make sure the flap is
smoothed flat.)

Insert three-hole punched paper so
that the holes line up along this side.

Make sure the paper lines up
evenly at this side of the feeder.

Don't stack paper above this line (=).

Before inserting the material,
move the paper selector lever
to the envelope icon (=) for
envelopes and to the paper
icon (&) for everything else.



Open the printer’s front cover.
Wait while the carrier moves to the center position.
Adjust the internal paper selector and extend the output tray.

The lever has three positions (two for paper, one for envelopes). I n the paper
(¢1) positions, the lever lowers the ink cartridge, bringing it closer for thin
materials; in the envelope (=) position, the lever raises the cartridge to leave
room for thick materials The far-left position is best for black-and-white text
on 20-pound paper; the center position is best for color printing, for heavy
black ink coverage, or for heavier paper.

Internal paper selector

T =
\ =

For paper, start with the
selector in the center
position. For envelopes,
move the selector
to the right.

To open the output
tray, pull here. (For
legal-size paper, leave

Close the printer cover.

Before you print, make sure that you set the software options to indicate the size and
kind of material you're using.

» Inthe Page Setup dialog box, indicate the size of the page
= Inthe Print dialog box, indicate the paper type

Printing
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Here are details about the kinds of materials you can use in your

Color StyleWriter 2500 printer.

Print material
Plain paper

Premium coated paper

Premium Plus
Coated Paper

Glossy paper

Transparencies

Back-print film

Envelopes

Labels

Maximum

100 sheets
50 sheets

50 sheets

20 sheets

20 sheets

15
20 sheets

Special instructions

Use 16- to 24-pound paper.

Use only paper designed for this printer.
The whiter side should face you.

= Use only paper designed for this printer.
= The whiter side should face you.

= Use only paper designed for this printer.
= To prevent misfeeds, put one sheet of plain paper at

the back of the stack.
The shinier side should face you.

= Use only transparencies designed for this printer.

The shiny side should face you.
The edge where the paper and transparency are
joined should point downward.

Use only film designed for this printer.

To prevent misfeeds, put one sheet of plain paper
at the back of the stack.

The chalky side should face you.

Make sure the envelope flap is folded down flat.

To prevent misfeeds, put one sheet of plain paper
at the back of the stack.

= The labels should face you.

In the Print dialog box, specify Plain as the paper
type.

The Color StyleWriter 2500 supports only the following sizes of materials:
U.S Letter, U.S Legal, A4 Letter, Executive, #6 envelopes, and #10 envelopes.
Dorit attempt to use other size materials, or printing errors may result.

For more information about the kinds of materials you can use with the Color
StyleWriter 2500, see Chapter 3, “ Tips on Paper, Quality, Speed, and Cost.”



Notes about envelopes

See the instructions that came with the programs you use to see if they offer
special, easy ways to format and print envelopes. If not, choose the envelope
size youre using in the Page Setup dialog box and format the envelope text as
you like

Printing a document

The next three sections explain the different ways you can print a document:

= Quick instructions for printing standard documents. To print documents that
dorit require any special options, see this section. (The section describes
what a “standard document” is)

= Detailed instructions for printing other documents. To print documents that
require any of the nonstandard options, see this section.

= Desktop printing. To print documents without leaving the Finder, see this
section. Desktop printing allows you to quickly send multiple documents to
multiple printers

Quick instructions for printing standard documents

Follow the instructions in this section to print a standard document:
» Standard paper size (85" by 11" in the United States)
= plain paper

= portrait page orientation (so when you look at the printed page, it is longer
than it iswide)

» No special effects and normal print quality

Assuming you have already selected the printer in the Chooser as described
in Chapter 1, and that the printer isfilled with standard paper, you need only
follow these steps:

While the document is in an active window, choose the Print command from the
File menu.

The Print dialog box opens on your screen.

Printing
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2  Click the Print button.

If the printer is off, it automatically turnsitself on and, after afew moments,
the document starts to print. If background printing is turned on, you can
conti nue working while the document is printing. You can also monitor and
control the documents that are waiting to print. (See “Printing While You Use
Your Computer” and “Monitoring and Controlling Background Printing,”

later in this chapter)

Detailed instructions for printing other documents

If your document is not standard (as defined in the previous section), follow
these steps:

1  Ifyou haven't already selected the Color StyleWriter 2500 in the Chooser, do so now.

You already selected the Color StyleWriter 2500 in Chapter 1, and if itsthe
only printer you ever use, you won't need to do it again. If you do need to
switch, see “Switching Between Printers” later in this chapter.

2  Load the paper, envelopes, or other materials into the printer, as described in “Loading
the Sheet Feeder,” earlier in this chapter.

Remember to adjust the external paper selector before filling the sheet feeder.
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3 While the document is active on your screen, choose Page Setup from the File menu and
make adjustments in the dialog box that opens.

If the default settings shown here are satisfactory, you can skip this step.

Color Stylellriter 2500 Page Setup - | Setthe options,
Page Size:[ US Letter | then click OK.
Look here to see the __| Lagout: [ garsders
effects of the options Scating (7): [ )
you choose. _ _
Orientation: I
ltem in dialog box What you use it for
Page Size Indicate the size of paper in the sheet feeder.
Layout Print 2 or 4 mini pages per sheet of paper.
Borders Put a border around the mini pages.
Scaling Enlarge or reduce the printed image. Type a number between 5 and
999 or choose a number from the pop-up menu.
Orientation Indicate whether the image on the page should be in portrait (normal)
or landscape (sideways) orientation.
Watermark Specify a background image to be printed on every page.

For more information about the layout, borders, scaling, and watermark
features, see “ Creating Special Effects on the Color StyleWriter 2500, later in
this chapter.

IMPORTANT Make sure you correctly indicate the size of the paper, envelopes,
or other material you have in the sheet feeder. If you change the page sizein
this dialog box, you might also want to look over your document to see if any
of the page breaks have changed.
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4

Choose Print from the File menu and make adjustments in the dialog box that opens.

Color StylelWriter 2500

[[W]} | Set the options,

Print Quality: O Best

image:_Color ]

Copies: Iil Pages: @ All O From: To: [ Cancel ] then click Print.

@® Normal O Draft e

Item in dialog box
Copies

Pages

Print Quality

Paper Type

Image

Notification

Color

Utilities

What you use it for

Type how many copies of the document you want.

Indicate how many pages of the document to print. To print the whole
document, click All. To print a range of pages, type the beginning and end
page numbers. As a shortcut, you can indicate the first page by leaving the
“From” box blank or the last page by leaving the “To” box blank.

Select which level of quality you want. Generally, the higher the quality, the
longer the document will take to print. The Draft option is available only
when you use Plain or Coated paper.

Indicate what type of material is loaded in the sheet feeder. For labels
and envelopes, choose Plain.

Indicate whether you want the document to print: in color, grays, or
black and white.

Choose how (if at all) to be notified when the document is finished printing.
For a visual alert, choose Message from the pop-up menu. For an audio
alert, choose a sound.

Open another dialog box, in which you can adjust color options, as
explained in "Adjusting Color Options,” later in this chapter.

Open another dialog box, in which you can set options to clean the
print head.

IMPORTANT Make sure the Paper Type pop-up menu accurately indicates what
you installed in the sheet feeder.



Click the Print button.

If the printer is off, it automatically turnsitself on and, after afew moments,
the document starts to print. If background printing is turned on, you can
conti nue working while the document is printing. You can also monitor and
control the documents that are waiting to print. (See “Printing While You Use
Your Computer” and “Monitoring and Controlling Background Printing” later
in this chapter,)

Desktop printing

Use one of the two methods described here to print documents without
leaving the Finder. Desktop printing is particularly efficient when you have a
number of documents you want to print at once or when you have a
document that you have already formatted.

= Drag theicons of the documents you want to print to the desktop icon of
the printer you want to use

] =

My Docurnent  Color Stylewriter 2500

or

» Select the icons of the documents you want to print then choose the Print
command from the File menu. The documents will be printed on the
default printer. (See “Switching Between Printers’ later in this chapter)

In either case the computer will show you the Print dialog box so you can
choose printing options. Make your choices, then click the Print button.

If the printer is off, it automatically turns itself on, and after a few moments,
the document starts to print. If background printing is turned on, you can
continue working while the document is printing. You can also monitor and
control the documents that are waiting to print. (See “Printing While You Use
Your Computer” and “Monitoring and Controlling Background Printing” later
in this chapter)

Printing
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Adjusting color options
To adjust the way colors are printed, follow these steps:
1  Choose Print from the File menu.

2 Inthedialog box that appears, click Color.

Color StyleWriter 2500 m
Copies: Iil Pages: @ Al O From: To: [ Cancel ]

Print Quality: O Best @ Normal O Draft

Paper Type Plan ] (Ccotor }— Click Color.
Image:[_Color_____ ]
Notification:|_None |

Some programs provide a checkbox you must click in order to print. See the
Read Me file for information about printing in color with specific programs.

3 Select your color options.

The printer blends the four ink colors in either a
repeating pattern of dots or a random scattering of
dots. Many people prefer the look of the Scatter
option. Choose the halftoning method you prefer.

To turn on color Color Stylelriter 2500|Color Options
matching, click the Halftoning Options:
ColorSync box so ) Pattern @ Scatter
there'san Xinit. _{ = cotorsync™
Matching Method:| Automatic - |
Printer Profile:| Automatic - |

The ColorSync color-matching system makes sure that colors look as
consistent as possible no matter what device you use to view them—monitor
or printer. In addition, ColorSync helps give you the best possible colors
when you export the image to another Macintosh computer with ColorSync
installed or print it on another color printer.

For more information on ColorSync, see Appendix D.

Note: The 13" monitor uses the default system profile If you are using a
different monitor, you should open the ColorSync contral panel and select the
correct system profile for your monitor or PowerBook display.
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With ColorSync turned on and the Automatic matching method selected, the
Macintosh chooses the best matching method for the contents of the
document you are printing. If you are not satisfied with the results, you can
choose the option you want from the Matching Method pop-up menu. Most
of the time, however, the Automatic setting is best.

e LH ~ Automatic— | Automatic lets the Macintosh
Photographic choose the best color-matching
Business Graphics method for your document.

If you have obtained additional printer profiles from other software
companies, you can use the Printer Profile pop-up menu to choose the one
you want. (The additional profiles should come with instructions telling you
how to choose the appropriate one)

Printer Profile:[ Automatic -] If you don't have additional printer profiles,
leave this set to Automatic.

When you've made your choices, click OK to return to the Print dialog box.
Click Print.

To save the ColorSync settings with this document, choose Save from the File menu.

Color printing quirks

Here is some additional information about color printing.

= Different programs may define colorsin different ways. When you choose
ared in one program, you may not be able to find an exact match in
another program. You can adjust the color in the second program until
youre satisfied with the printed results To see how different programs
define color, consult the manuals that came with your programs.

» Color printing takes longer than black-and-white printing. The printer must
sort through more data and use more ink to complete the job, and this
takestime

Printing
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Creating special effects on the Color StyleWriter 2500

Chapter 2

You can create a number of special effects on the Color StyleWriter 2500 by
selecting options in the Page Setup, Print, and Color Options dialog boxes.

Enlarging or reducing the printed image

You can enlarge or reduce the image on the Color StyleWriter 2500, much as
you can on many photocopying machines Reducing the printed image by a
small amount is a popular way to fit a little extra onto each page

Choose Page Setup from the File menu.
Enter a scaling percentage.

You can type a number from 5 to 999 or use the pop-up menu. Numbers
smaller than 100 reduce the image; numbers greater than 100 enlarge it.

Note: Changing the scaling may also change the pagination of your
document.

Printing a watermark on each page of your document

Traditionally a watermark is a trand ucent image impressed on a piece of
paper that you can see only by holding the paper up to the light. The Color
StyleWriter 2500 carit do that, but it can put an image on each page of your
document, creating the illusion of awatermark. The Color StyleWriter 2500
comes with a number of watermarks already installed, and you can create
more, as described in the next section.

To print a document with awatermark in the background, follow these steps:
With your document on the screen, choose Page Setup from the File menu.
In the Page Setup dialog box, click the Watermark button.

Another dialog box opens.



3

4

Look here to see the _|

effects of the scaling
option you choose.

Choose the watermark you want from the pop-up menu.

Color StylelWriter 2500 Watermark Options

latermark: XD

Confidential (Color)
Contract (Color)

Do Not Copy (Color)
| Draft (Color) .
Final (Color)

Personal (Color)
Proposal (Color)

For Your Information (Color)

Adjust the Density and Scaling.

Color Stylelriter 2500 Watermark Options

Watermark[_Braft

Density:

ML -~ Centered
Align Top Left
Stretch to Fit

Use this pop-up menu to
position the watermark.

Move this slider to adjust
how dark the watermark
should print.

When the Dengity dider is al the way to the right, the watermark will print as

dark asit isin the original watermark file

Note the different effects of the scaling options:

= Centered scalesthe image the same amount in both the horizontal and the
vertical directions, then centersit on the page

= Align Top Left places the image at the upper-left corner of the page without

scaling the image at all.

» Stretch to Fit scales the image so it fills the page, even if the horizontal and
vertical directions have to be scaled by different amounts. This may distort

theimage

Click OK to return to the Page Setup dialog box.

The settings you choose are remembered by this document but do not affect

other documents.

Printing ‘
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Creating your own watermarks

You can use any program that can save PICT or PICT2 format files to create
your own watermarks For example you can create a watermark with your

company’s logo on it.

Create the file with a drawing program or any program that can save PICT or PICT2 files.

Here are some tips for making effective watermarks:

= Make the watermark with saturated colors. When you print a document,
you can use the Density control to make the watermark lighter.

= Asyou draw the image, keep in mind how the watermark scaling options

affect the placement of the image when it is printed.

~

Watermark file Printed with Printed with Printed with
Align Top Left Centered option Stretch to Fit
option option

= The printing software determines the placement of the watermark based on
where it calculates the upper-left and lower-right corners of the image are
If you want to have more control over the placement, you can use your
drawing program to place a dot above and to the left of the image in the
watermark file to define a new upper-l€eft corner. If you dorit want the dot
to be visble in your printed document, make the dot white

Dot

Watermark file

Printed with
Align Top Left
option

Printed with
Centered option

Printed with
Stretch to Fit
option



2 Save the PICT file inside the Printing Prefs folder.

To find the Printing Prefs folder, open the System Folder on your hard disk,
then open the Preferences folder. The name you save your file as will be the
name that appears in the Watermark dialog box.

Note: If you send the watermark to someone, they also need any fonts that
it uses

Printing 2 or 4 mini pages on each sheet of paper

One of the most popular reasons to print mini pages is to save paper when
printing long drafts or to make a compact printout of a reference document,
such as an address book.

1  With your document on the screen, choose the Page Setup command from the File
menu.

2 Choose how many pages you want to appear on each sheet of paper from the Layout
pop-up menu.

Color Stylellriter 2500 Page Setup

Look here to see the |
effects of the option
you choose.

3 Ifyou'd like a border around each mini page, click to put an X in the Borders checkbox.

Printing
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Selecting a halftoning method

Halftoning is a process in which colors are blended by using an arrangement
of different-colored dots. The Color StyleWriter 2500 blends colors by using
either arepeating pattern or arandom scattering of dots. The random method
generally produces a smoother appearance, though it takes longer to print.
The default choice is random scattering.

To change the halftoning method, follow these steps:
When you are ready to print, choose Print from the File menu.
The Print dialog box opens.

Click the Color button to open another dialog box.

Click Pattern or Scatter.

To return to the Print dialog box, click OK.

Switching between printers

Chapter 2

If you have more than one printer available, you must select which printer you
want to use The printer you select is called the default printer.

I s A bold outline around a desktop printer icon indicates that
it is the default printer, where all your documents will print
=== until you indicate otherwise.

A plain outline around a desktop printer icon indicates that
it is not the default printer.

To change the default printer, use one of these three methods, as described in
the next sections

» Drag the document you want to print to a desktop printer icon.
» Select the printer by using its desktop printer icon.
» Select the printer by using the Chooser.

Note: Switching between printers may change how much information you
can fit on apage It's best to choose a printer before you spend much time
pagi nating the document.



Drag the document you want to print to a desktop printer icon

You can switch to a new default printer by dragging the icon of any document
you want to print to the icon of the printer you want to use (See “ Desktop
Printing” in the section “Printing a Document” earlier in this chapter)

Select the printer by using its desktop printer icon

If you already have a desktop printer icon for the printer you want to use,
follow these steps to select a new default printer without immediately printing
anything on it:

Click the icon of the desktop printer you want to use.
A Printing menu appears on the menu bar at the top of the screen.
Choose the Set Default Printer command from the Printing menu.

Until you choose another printer, the Print command will send your
documents to this printer.

Select the printer by using the Chooser

If you don't have a desktop printer icon for the printer you want to use, you
must select the printer by using the Chooser. The Chooser will then create a
desktop icon for the printer that you select and make it the default printer.

Select the Chooser from the Apple (&) menu.
Select the printer that you want by clicking its icon.
Close the Chooser by clicking the close box in its upper-left corner.

When you dose the Chooser, it creates a desktop printer icon for the printer
you selected.

Printing
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Creating, throwing away, and manipulating desktop printer icons

To create a desktop printer, select the printer in the Chooser. After you close
the Chooser, the icon will appear on your desktop. See “Select the Printer by
Using the Chooser,” in the section “Switching Between Printers” earlier in
this chapter.

You can also do the following with desktop printer icons:

Throw away the icon. Drag the icon to the Trash. You cant throw away a
desktop printer icon while the printer is printing a document. (You can
create another desktop printer icon for that printer whenever you like)

Note: You must always have at least one printer icon on your desktop. If
you throw away the last icon, it will immediately be created again.

Rename the icon. Rename the icon as you would any other Finder icon.
Click the name to highlight it, then type the new name This changes the
name of the icon, not the name of the printer.

Move the icon. You can drag the icon anywhere you like on the desktop.
However, you cannot move it off the desktop.

Create an alias for the icon. You can create an alias for a desktop printer as
you would for any Finder icon by selecting the icon and choos ng the
Make Alias command from the File menu. You can move the alias
anywhere on or off the desktop.

Determining the status of a printer by looking at its icon

Chapter 2

You can tell the status of a printer by looking at its desktop icon:

_|L.__|]_— Plain icon indicates a printer Stopped icon indicates you have
_____ that is not currently chosen stopped the print queue.

i f  for printing.

[ 1y Default icon indicates the printer Error icon indicates there is an
E you have currently chosen to error on this printer. Double-click
=g printon. & the icon to see a message.

Printing icon indicates a Disabled icon indicates this
document is printing on this desktop printer is not available.

printer. See Chapter 5.




Printing while you use your computer

Click this icon.

You can continue to work on your computer while printing on the

Color StyleWriter 2500. The feature that gives you this ability is called
background printing and is automatically turned on when you install the
Color StyleWriter 2500 software. (If you use QuickDraw GX, background
printing is always turned on)

To turn background printing on or off, follow these steps:
Select Chooser from the Apple (@) menu.
The Chooser opens.

Click the Color SW 2400 icon in the Chooser.

dppleShare
If you don't see the
m—0 fyoud _
icon, click this arrow
Key hocess until it appears.

Click to turn background printing on or off.

f——————— Background Printin
gt
1 Active

i Inactive

Click On or Off.

AppleTalk

Click the close box in the upper-left corner of the Chooser.

Once background printing isturned on, it isin effect whenever you print,
until you turn it off. When you click Print in the Print dialog box, a message
appears for amoment to tell you the document is being prepared. Once the
message disappears, you can continue other work. Your computer may pause
occasionally while it processes the document for printing. See “Monitoring
and Controlling Background Printing,” next, for more information.
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Monitoring and controlling background printing

Chapter 2

If you are using background printing, you can use the desktop printer features
to monitor and control your print requests. To learn how to turn background
printing on and off, see “Printing While You Use Your Computer,” earlier in
this chapter.

To monitor or control a print request, follow these steps:

Double-click the desktop printer icon you're interested in.

[

Calor Stylewriter 2500

A window opens listing the documents that are printing or waiting to print:

E[I==————— Color Stylelriter 2500 ==————15
[ waie ][ semour |
Decuments in Dueve: 3 — : Column titles (click to sort)
Docurnent Marne FPages Copies  Print Time
Letter to Zachary (print) 1 1 Urgent __The document that'S
@ currently printing
stermn .0 —-kRea e ... ormna G "+ 1
£ sustem 7.5 —Read Me 2o Horma — _Documents waiting to print
@ E-mail to Jacob (print) 1 1 Fri, Mar 22,1996, 11:00 AM
]
2] EE

About print requests to shared printers. If you use ColorShareto print a
document on a printer that is not directly connected to your computer, your
print request will be visible in this window for only afew moments. Then the
print request moves to the desktop printer on the computer that is directly
connected to the printer.

Decide what you'd like to do.

= To delete a print request, select itstitle or icon (by dicking it), then click the
Remove button. (You can select more than one item at atime by holding
down the Shift key while dicking,) You can also drag the icon for the print
request to the Trash. Note that these methods delete only the print request,
not the document itself.



To put a print request on hold, select itstitle or icon (by clicking it), then click
the Hold button. The print request will stay on hold until you select itstitle
again and click the Resume button. You can also put the print request that's
currently printing on hold by dragging it to the list of documents waiting to
print.

To indicate that a print request is urgent, select its title or icon (by clicking it),
then choose Set Print Time from the Printing menu. In the dialog box that
opens, dick Urgent. This moves the print request to the top of your list.

To indicate that a print request should not print until a future time, select its title or
icon (by dicking it), then choose Set Print Time from the Printing menu.
In the dialog box that opens, click At Time, then set the time you want.

To sort the list of items waiting to print, click the title of the column you want to
sort by. For example, to sort by the name of the document, click Document
Name (You can also sort by choos ng the commands in the View menu,)
The column title you sorted by is underlined. Sorting the items does not
change the order in which they will print. To see and change that order,
sort by Print Time,

To change the order of the items waiting to print, dick the words Print Time, and
then change the items place in the list by dragging their titles

To temporarily stop all your items from printing on this printer, choose Stop Print
Queue from the Printing menu. To resume using the printer, choose Start
Print Queue from the Printing menu. If youre usng a PowerBook, this can
be a good way to save print requests while youre on the road until you get
back to your printer.

Shorteut: The commands to start and stop the print queue are available
without opening the window for the printer, if the printer'sicon is selected
on the desktop.

To move a print request from one printer to another printer of the same type, drag
the icon for the print request to the icon of the printer where you want to
move it. If youre not sure whether the two printers are of the same type,
try moving the print request anyway—the printer software worit let you
move a print request to an incompatible printer.

Printing
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Sharing your printer with other users

Chapter 2

If your computer is connected to other computers over an AppleTalk network,
you can allow others on the network to print on your Color StyleWriter 2500.
The technology that lets you do thisis called ColorShare

Note: Before you can share the printer, other users must install the Color
StyleWriter 2500 printer software. In addition, everyone who shares the
printer must first open the Chooser and select the Color SW 2500 icon.

Note the following points about ColorShare:

Even though you are sharing the printer over a network, the printer must
still be connected directly to a single computer with the provided cable, as
described in “ Connecting the Printer to Your Macintosh’ in Chapter 1

For others to be able to use the shared Color StyleWriter 2500 printer, your
Macintosh must be turned on.

When other users print on a printer connected to your Macintosh, you may
notice that your computer pauses occasionally while you work. Because the
printer is attached to your Macintosh, you can see what's being printed by
opening the desktop printer icons, as described in “Monitoring and
Controlling Background Printing,” earlier in this chapter.

These instructions work only if you do not use QuickDraw GX software,
and only others who do not have QuickDraw GX can share the printer.
(QuickDraw GX users can share a printer only with other QuickDraw GX
users. They share the printer by clicking itsicon, and then choosing
Sharing from the File menu.)



To share the printer with other non—QuickDraw GX users, follow these steps:
1  Select Chooser from the Apple (6) menu.

2 Inthe Chooser dialog box, do the following:

E[1=————— Chooser
. . . Connect to:
First, click this icon. o ——
(If you don't see the ,,p,ﬂEhm dem Part
icon, use the scroll
bar and arrows to 0
fll"ld |t) Key Access Laser'writer

AppleTalk Zones:
Halftime

Hardware Test Lab Then click Setup.
Imaging [ ]

Instructional Products Back d Printi

Japan ackground Printing

Montana - . @ on O off

Second Floor i

Third Floor AppleTalk gﬁncat;;e\,e

3 Inthe Setup dialog box, make the changes you want.

To share your printer, - -
click to place an Xin Color Stylellriter 2500 Sharing
this box. [ Share this Printer
EUse this sharing feature to allow other people to use the printer . .
{attached ta this Masintash To make your printer available
Type aname for Name:[Eric's Color Printer only to people you choose, type
your printer here. Password:| | a password here.
To avoid .
confusk()n give it ClKeep Log of Printer Usage To use your printer, others must type
o the password exactly as you have, so
a unique name.) (camcet J__% N[ remember how you typed the word

including where you used uppercase
and lowercase letters or spaces before
or after the word.

The name you give the printer is the name others will use to select the printer
in the Chooser.
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4 To keep arecord of what's printed on your printer, click the “Keep Log of Printer Usage”
checkbox to put an Xin it.

You can open and print the log with SmpleText, TeachText, or another word-
processing program. To find the log file, open your System Folder; then open
the Preferences folder and the Printing Prefs folder. Thefileis called Color
StyleWriter 2500 Log.

Note: You can keep alog even if your printer is not shared.
5 Click OK to close the Setup dialog box.

Sharing works only if background printing is turned on. If it is not turned on,
ColorShare turnsit on.

6  Close the Chooser by clicking the close box in its upper-left corner.

If the Color StyleWriter 2500 software has been installed on their Macintosh
computers, other users connected to the network can now use your
Color StyleWriter 2500, as described in the next section.
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Printing on a shared Color StyleWriter 2500

After you turn on ColorShare (as described in the previous section), others on

your network can share your printer.

IMPORTANT People on the network who want to print on your shared printer
must install the Color StyleWriter 2500 software on their computers as
described in Chapter 1. After the new software isinstalled, network users

must follow these steps:

1  Select Chooser from the Apple (6) menu.
The Chooser opens.

2 Make the following selections in the Chooser:

First, click this icon.

S[IE==————"——— (hnserE"cr—————————|

Connect to:

(If necessary, use the

[B)Printer Part <+

scroll bar and arrows RZ|Modem Part

AppleShare

to find the icon.) & Eric’s Colar Printer

@l Mike's Color Printer
& Myra’s printer

& Randy's printer

& Suzanne's Printer

0

Key hroess

Laserwriter

AppleTalk Zones:

Second, if the __|_jemsrems

network has zones, Hardware Test Lab
i Imaging Iy
. click thelone Instructional Products p — P
containing the printer Japan ac @g)r;LrJ'no ;? ing
you want to use. gontﬁgaﬁ
econd Flaor Active
Third Floor AppleTalk g Inactive

Third, click the name
of the printer you
want to use. If the
printer requires a
password, a dialog
box appears asking
you to type it.

3 Close the Chooser by clicking the close box in its upper-left corner.

After you close the Chooser, a desktop printer icon for the Color StyleWriter

2500 appears

Anyone who completes these steps can print on the shared printer.

When you print a document to a shared StyleWriter, your computer transfers
the request to the computer directly connected to the printer. As soon as the
transfer is complete, your computer thinks the document has finished
printing. You can continue monitoring the print request on the computer that

is directly connected to the printer.

Printing ‘
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Connecting a Color StyleWriter 2500 to a LocalTalk or EtherTalk network

If you have the optional Color StyleWriter Local Talk Module or EtherTalk
Adapter, you can connect a Color StyleWriter 2500 printer directly to a

Local Talk or EtherTalk network. (Make sure you use the model that works
with the Color StyleWriter 2500)

To attach the Local Talk Module or EtherTalk Adapter and connect your Color
StyleWriter 2500 to the network, follow the instructions that come with the
module Once the printer is on the network, its name appears in the Chooser
just like the names of other network printers.

Chapter 2

El

Chooser

#ppleShare

0

Key Access

Lazerwriter

Caonnect to:

I3 Printer Port
f£]Modem Port

&5 CSW on Network

AppleTalk Zones:
Halftime
Hardware Test Lab
Imaging
Instructional Products
Japan

Montana

Second Floor

Third Floor

fre————————n Figclqround Printing
R
(Rename... | @ 0On O 0ff

) Active

AppleTalk ) Inactive

If you want to change the name, click Rename. I n the dialog box that appears,
type anew name for the Color StyleWriter 2500 printer. (Note: Anyone on
the network can change the name)

|I .
R Color Stylelllriter 2500
] ename Color Stylelllriter

=t

Current Name: "CSW on Network"

LIETRETHEHICS I on Network

[ cancel ] | Rename ||

| Type a new name, then

click Rename (or press Return).



Tips on Paper, Quality, Speed, and Cost

This chapter explains how to use different materials and printing options to
meet your needs

Choosing print materials

Here are some tips on when and how to use different print materials.

Plain paper

Use plain paper for everyday printing.

Print quality may vary depending on the manufacturer of the paper.

If youre not happy with one kind of paper, try a different brand. For
consistent results, use one of the special papers designed for the

Color StyleWriter 2500 printer.

You can use any plain paper, including plain copier paper. Paper weight
can range from 16 to 24 pounds, though 20-pound paper is recommended.
Dont use erasable typing paper, damaged or wrinkled paper, stapled paper,
or multipart forms (“carbonless carbons’).

Plain paper almost always has one side that is better for printing than the
other. See the package label to determine which side is better, and load that
Sde so that it faces you.

49



50

Chapter 3

Premium coated paper

Use premium coated paper for exceptional print quality—for example, for a
final draft, a colorful notice, or the master copy of a presentation. Colors
appear richer and more vibrant on such paper.

» Use only coated paper designed for use with the Color StyleWriter 2500.

= One side of the paper is alittle whiter than the other and is better for
printing. See the package label on the coated paper to determine which
sde s better, and load that side so that it faces you.

Premium Plus Coated Paper
Use Premium Plus Coated Paper for exceptional image quality—for example,
when printing a photographic picture. Images look smoother on such paper.

= Useonly Applés Premium Plus Coated Paper designed for use with the
Color StyleWriter 2500 printer mechanism and the printer'sinks.

= One side of the paper is alittle whiter than the other and is better for
printing. See the package label on the coated paper to determine which
side is better, and load that side so that it faces you.

Glossy paper

Use glossy paper for the highest print quality you can get on opague paper—
for example, for color proofs

= Use only glossy paper designed for use with the Color StyleWriter 2500.

= When loading a stack of glossy paper into the sheet feeder, put asingle
sheet of plain paper at the back of the stack to prevent misfeeding.



Back-print film

Use back-print film for the highest print quality of all—for example, for
digitized photographs or important client presentations. Back-print film has a
shiny surface and works exceptionally well when displayed by backlighting.

= Use only back-print film designed for use with the Color StyleWriter 2500.
= Load back-print film so that the chalky side faces you.

= When loading a stack of back-print film into the sheet feeder, put asingle
sheet of plain paper at the back of the stack to prevent misfeeding.

= Inthe Print dialog box, be sure to select Back Print as the paper type

» The printer automatically reverses the image and printsit on the filmis
chalky side so that the image looks correct when viewed from the
shiny side

Transparencies
Use transparencies when you want to present your document on an overhead
projector.

» Use only transparencies designed for use with the Color StyleWriter 2500.
These special transparencies have a sheet of paper attached to them; leave
the paper attached until after printing.

= Load the transparencies so that the shiny side faces you and the edge
where the paper and the transparencies are attached points downward.

Tips on Paper, Quality, Speed, and Cost
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Quiality

Select Best quality.
Best quality takes

For highest-quality printing, choose Best quality and print on coated or

glossy paper, back-print film, or transparencies.

Color StylelWriter 2500 m
Copies: IEI Pages: @ Al O From: To: [ Cancel ]

longer to print, but L pring quatity: ® Best O Normal Cioraft

you get better
quality—even on plain
paper.

To turn on color
matching and get the
best-quality color

printing, click to __ll 7 cotorsyne™

put an X in the
ColorSync check box.

E Chapter 3

Image:[_Color <]
Notification:_None =]

Also use the following selections in the Color Options dialog box. (To display
the dialog box, click the Color button in the Print dialog box.)

Color Stylel'riter 2500 Color Options
Halftoning Options:
) Pattern ) Scatter
I
Matching Method:[ Automatic hd |
Printer Profile:[ Automatic v |

Many people prefer the
look of the Scatter
halftoning method.

For more information on color matching, see “Adjusting Color Options’ in

Chapter 2.



Speed

For faster printing, change the Print Quality setting in the Print dialog box.
(To display the dialog box, choose Print from the File menu))

Color Stylelriter 2500 m
Copies: Iil Pages: @ AIl O From: I_I To: I_I Cancel
Select Normal of —{l print quality: OBest @ Normal Cyoraft .
Draft. Draftis faster || paper Type: Plain ]
than Normal. Image:[ Color ______ +)
Notification:_None ]

Color printing takes longer than black-only printing.

The optional high-performance black ink cartridge is designed for efficient,
high-speed, black and grayscale printing.

Cost

To reduce the amount of ink you use, select Draft quality in the Print dialog
box whenever possible

L eave the printer's cover shut. (Every time you open and shut the cover, the
printer usesink asit cleans the print head)

Dorit unplug the printer unnecessarily or connect it to a power strip that you
turn off occasionally. When reconnect the power, it usesink asit cleans the
print head.

Switching cartridges between the color cartridge and an optional high-
performance black cartridge uses extraink. Dont switch cartridges
unnecessarily. If you plan to print many pagesin black or grayscale (for a
cumulative total of 20 or more pages), use the optional high-performance
black cartridge
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Maintaining Your Printer

It doesrit take much effort to keep your Color StyleWriter 2500 printer in
good working condition. You smply have to replace the ink tanks when they
run out of ink and clean the printer or print head if you notice a problem.
(And occasionally, you should replace aworn-out ink cartridge)

For other service, see the information about service and support that comes
with your Color StyleWriter 2500.

IMPORTANT Follow all the safety instructions given at the beginning of
Chapter 1

Replacing ink tanks in the four-color ink cartridge

The four-color ink cartridge contains two separate ink tanks, one for black
ink and one for cyan, magenta, and yellow inks. This means that when you
run out of black ink, you dorit have to replace both tanks. (Most people use
more black ink than any other color)

WARNING Use only ink designed for use with the Color StyleWriter 2500
and 2400. The wrong ink can damage the print head and the printer,
and such damage is not covered under the warranty.
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When to change ink tanks

Look carefully at your printed documents to seeif a color is missing or faded.
Sometimes it's obvious—such as when you run out of black ink. At other
times you may notice that the colors seem wrong—such as when youre
printing a nature scene and you run out of yellow.

The best way to verify that ink is running low isto print the test page. (For
details, see “Checking the Print Nozzles’ in Chapter 1)

How to change ink tanks
Turn on the printer.

Open the printer’s front cover.

Wait while the carrier moves to the center position.

Remove and discard the old ink tank.

IMPORTANT You can use the same ink tanks and ink cartridges in both the
Color StyleWriter 2500 and Color StyleWriter 2400.



7

Remove the new ink tank from its packaging.
Remove the plastic cap from the bottom of the ink tank.

Don't let anything touch
the openings. The ink @
may cause stains, and

any contaminants may
diminish the print quality.

Slide the tank into the cartridge, and push it down so it snaps into place.

IMPORTANT Make sure you put the color ink tank on the left and the black ink
tank on the right.

Close the printer cover.
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Replacing the ink cartridge

Chapter 4

Theink cartridge contains the print head, the device that takes the ink and
sprays it on the paper. The Color StyleWriter 2500 printer comes with a four-
color cartridge with replaceable ink tanks. You can also purchase an optional
high-performance, black-only cartridge The black-only cartridge has enough
ink to print about 900 pages at 5% coverage—when ink covers 5% of the
page. (A typical double-spaced page has about 5% coverage) The four-color
cartridge lasts about twice as long, because you can replace its ink tanks

When to replace the four-color cartridge

Age isthe primary factor in determining when a four-color cartridge wears
out. If youve done alot of printing with your cartridge and notice a gradual
deterioration in print quality, it may be timeto install a new four-color ink
cartridge Before you do, try printing the test page in case a clogged nozzle is
the problem. (See “ Checking the Print Nozzles’ in Chapter 1)

Note: A new four-color ink cartridge comes with fresh ink tanks already
installed.

When to replace the optional black-only ink cartridge

Knowing when to replace the black-only cartridge is fairly smple When it
runs out of ink, it stops printing.

Note: If you see other problems with black-only print quality, such as
unwanted white lines in a document, try printing the test page. (See
“Checking the Print Nozzles' in Chapter 1)

How to find ink cartridges

You should be able to find cartridges, ink tanks, and other supplies for your
Color StyleWriter 2500 printer at any Apple-authorized dealer.



How to replace the ink cartridge

IMPORTANT Before replacing the cartridge, try printing the test page (See
“Checking the Print Nozzles’ in Chapter 1)

Turn on the printer.

Open the printer’s cover.

Wait while the carrier moves to the center position.

Raise the bright blue lever on the carrier and remove the cartridge.

Dispose of the cartridge.

IMPORTANT Be careful not to touch the print head, or you may temporarily
stain your fingers with ink.

Remove the cover from the plastic tub that contains the new cartridge.
Grasp the ink cartridge by its sides and remove it from the plastic tub.

You may safely touch the black plastic, but be careful not to touch any
other part.

Maintaining Your Printer

59



6  Remove the bright orange cap from the cartridge’s print head.

After you snap it off,
dispose of the cap.

7  Peel the orange tape off the print head.
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8  Slide the cartridge into its place in the printer.

10  Close the printer cover.

Now you can open any document you want and print it as usual.
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Storing the ink cartridge you aren't using

Chapter 4

The Color StyleWriter 2500 comes with a four-color cartridge In addition,
you can purchase the optional high-performance black cartridge While they
are sealed in their original packaging, the ink cartridges are protected. If you
open both packages and switch ink cartridges for printing different
documents, be sure to store the one youre not using in the storage case
supplied with your Color StyleWriter 2500. The storage case keeps the print
head from drying out and prevents accidents with ink stains.

Be careful not to touch this area on the ink
cartridge, or you may stain your fingers with ink.

Once youve removed both cartridges from their original packages, always
keep one insde the printer and the other in the storage case

IMPORTANT If you have only one ink cartridge, leave it insde the printer.



Cleaning the outside of the printer

Before you clean the printer, turn it off and unplug the power cord. Then
wipe the outside of the printer with a clean, soft cloth dampened with water.
If necessary, you can use amild soap or detergent. Be careful not to get any
liquid in the power cord receptacle

WARNING Dont use ammonia-based or alcohol-based cleaners on or
around the printer—they may react with the plastic.

Cleaning the inside of the printer

Occasionally you may need to wipe off paper dust or drops of ink insde the
printer. Turn the printer off and unplug it. Then open the printer and carefully
clean the rollers and platen with a soft, dry cloth.

If necessary, you
can clean the rollers
and platen with a
soft, dry cloth.

WARNING Dorit use any liquid cleaners inside the printer.

Maintaining Your Printer






Troubleshooting

This chapter provides solutions to some problems that you may encounter
while using your Color StyleWriter 2500 printer.

As long as you follow the maintenance instructions in Chapter 4, youre not
likely to have any problems with your printer. The most common source of
trouble is faulty software installation. To avoid these problems, follow the
software installation instructions in Chapter 1

WARNING |f you have a problem with your Color StyleWriter 2500
printer and nothing presented in this chapter solvesiit, consult the
service and support information that came with the printer for
instructions on how to contact an Apple-authorized service provider or
Apple for assistance If you attempt to repair the Color StyleWriter 2500
yourself, any damage you may cause to the printer will not be covered
by the limited warranty on your printer. Contact an Apple-authorized
dealer or service provider for additional information about this or any
other warranty question.
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Safety precautions
To prevent damage to the Color StyleWriter 2500 printer and harm to yourself
and other users, follow these safety tips

= Dorit touch anything inside the printer except as described in the
instructions in this manual. Otherwise, you may damage delicate
mechanical parts

= Dorit shake ink tanks or hold them with the ink opening pointing down.
Ink can leak out and cause stains.

= Dorit touch the ink opening on an ink tank.
= Dorit 0il the insde of the printer.
= Dorit attempt to disassemble the printer.

= Before you unplug the printer, make sure it is turned off. (The green power
light should be off) Turning the power off ensures that the carrier has
returned securely to its home position and the cartridge has been capped.

The Chooser doesn’t show the Color SW 2500 icon

If you open the Chooser and dont see the Color SW 2500 icon, you probably
need to install the appropriate printer software. For instructions, see
“Installing Your Printer Software’ in Chapter 1

Installation is unsuccessful

If amessage tells you that installation was not successful—or if you have to
repeatedly swap between the same two disks—check to make sure you
restarted your computer with all your software extensions off as explained in
Chapter 1 If that doesrit work, try removing corrupted fonts or performing a
custom installation, as described in the next two sections.
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Removing items from your Fonts folder to solve installation problems

Itemsin your current Fonts folder can interfere with successful installation of
the printer software To correct the problem, follow these steps:

Quit all programs you are currently running.
Open the Fonts folder (inside the System Folder) on your Macintosh.

Drag the following files out of the Fonts folder. (Look for files with exactly these names.)
= Avant Garde

= Bookman

= Delphian

= Garamond Narrow

= Helvetica Black and Helvetica Compressed
» Lubalin Graph

= LucidaBright

= Machine

= N Helvetica Narrow

= Nadianne

= New Century Schibk

= Old English Text

= Onyx

= Oxford

= Swing

» Zapf Chancery

» Zapf Dingbats

= Zed

You can put the fonts temporarily into a new folder and drag the folder to
your desktop. Then, after you install the Color StyleWriter 2500 software
(including these fonts), you can drag the temporary folder to the Trash.

Repeat the software installation procedure in Chapter 1.

For more details about fonts, see Appendix B.

Troubleshooting

67



Using the Custom Installer to solve installation problems

For another way to work around problems with corrupted fonts, you can
install the printer software without installing the fonts that come with the
printer. (The disadvantage is that you worit be able to use these fonts if you
dorit already have them)

1 Insert Color StyleWriter 2500 Disk 1 into a floppy disk drive.
If necessary, open the disk icon.

2 To start the Installer program, double-click its icon.

3 Inthe Welcome dialog box that appears, click Continue.

4 Inthe Installer dialog box, choose Custom Install.

Install Color S 2500 E=—————H5

+Easy Install
Choose __| s
Custom Install Custom Remove |
from this Color StylelWriter 2500 Software
Pop-up menu.
------ Destination Disk
Eignt sk
— - -
Your Hard Disk I Install I

[
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First, click this
checkbox. (An X
appears to show it's
selected.)

Second, make sure
the disk named here
is the one on which
you want to install the
printer software.

(If not, click Switch
Disk until the correct
name appears.)

In the Custom Install dialog box, click the QuickDraw Printer Software checkbox.

Install Color SW 2500 EiaF="———V11
[ Custom Install  « |
Check features to be installed
[<] QuickDraw Printer Software (2 |3
[ Desktop Printing Software [E]
] GH Printer Software [E]
[ serial Switch for Mac 114, Quadra 900 and 950 @
[ ColorSync™ 2.0 Software [E]
[» (] TrueType Fonts [E]
]
Disk space available: 17,111E Selected size: 1,074
------ Destination Disk
Fient Hisk i '
— : Finally, when you're
Vour Hard Disk [ Tostan )} ready to begin, click
@ Install.

When you see a message on your screen, follow the directions and insert the next disk.

The Installer gjects disks and asks you to insert others. Keep following the
instructions on the screen until the installation is complete

When you see a message reporting that installation was successful, click Restart.

The Installer restarts your Maci ntosh.

The computer crashes while attempting to print

When a computer suddenly stops working—either a message on the screen
tells you a system error has occurred, or the mouse and keyboard act as if
they're disconnected—the computer has crashed.

If your computer often crashes after you tell it to print a document, your
printing software may have become corrupted. Reinstall the printer software
by following the instructionsin “Installing Your Printer Software’ and
“Telling Your Computer to Use the Color StyleWriter 2500” in Chapter 1

Troubleshooting
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The computer doesn't recognize the Color StyleWriter 2500

If you have selected the Color StyleWriter 2500 in the Chooser but nothing
prints, or you get a message that no Color StyleWriter 2500 is connected, one
of the conditions in the list that follows may be the cause

Note: Before you try to solve the problem, open the Color StyleWriter 2500
desktop printer icon to seeif there are any error messages and to check how
many print requests are waiting. If you repeatedly tried to print a document,
there may be multiple copies waiting to print. You can delete anything you
dorit want by selecting itstitle, and then dicking the Remove button. See
“Monitoring and Controlling Background Printing” in Chapter 2.

= A plug may be loose To make sure that al cables are securely connected,
turn off the computer and the printer, then unplug each end of each cable
you want to test and plug it back in. For connection instructions, see
Chapter 1

= You may have indicated the wrong port in the Chooser. Open the Chooser
and change the port selection. (Look at the back of the computer to see
whether you plugged the printer into the computer's printer port [&] or
modem port [¥])

= If you are trying to use a shared printer connected to another computer and
the printer name isnt listed in the Chooser, make sure that the other
Macintosh is turned on and connected to the network. Also make sure that
the printer is set up to be shared. Then try again to select the printer in the
Chooser. (Note: QuickDraw GX users can share a printer only with other
QuickDraw GX users and non—QuickDraw GX users can share only with
other non—QuickDraw GX users) See the instructions in “Sharing Your
Printer With Other Users’ in Chapter 2.

= You may be using the wrong printer software Make sure you installed the
software as described in Chapter 1 and that you have selected the printer as
described in “Telling Your Computer to Use the Color StyleWriter 2500,
also in Chapter 1

= |f youre using a PowerBook computer with an internal modem, change the
serial port setting to Normal or External. For details, see “Special
Information for PowerBook Owners’ in the section “ Telling Your
Computer to Use the Color StyleWriter 2500” in Chapter 1
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» |If your computer is not connected to a network, turn off AppleTalk in
the Chooser.

= The printer may need to be reset. Turn the printer off, count to five then
turn it back on.

If you still canit resolve the problem, the printer may not be working properly.
See the information about service and support that came with your printer.

Desktop printer icon problems
A desktop printer icon appears again as soon as | drag it to the Trash.

You must always have at least one desktop printer icon. If you drag your last
desktop printer icon to the Trash, the computer instantly creates another one
just like it.

If you don't want to use desktop printers at all and you have System 7.5 or
later, you can use the Extensions Manager control panel to turn off Desktop
PrintMonitor, Desktop Printer Extension, and Desktop Printer Spooler. Or
you can use the Installer's Custom Remove feature to remove the desktop
printing software, as described in Appendix F

An X appears over the desktop printer icon.

When a desktop printer is not working, its icon appears with an X over it.

= You may have started the computer with a different startup disk or
temporarily turned off all the software extensons. When you restart the
computer as usual, the icon will return to normal.

= You may have removed the desktop printing software that created the
printer icon. If you meant to do so, you can drag the icon to the Trash. If
not, you can reinstall the software as explained in Chapter 1

A PowerBook has trouble printing to the Color StyleWriter 2500

Some PowerBook computers have special requirements for printing. See
“Special Information for PowerBook Owners’ in the section “ Telling Your
Computer to Use the Color StyleWriter 2500” in Chapter 1

Troubleshooting
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The lights indicate a problem

Chapter 5

Power button (®)
Power light

Error light (sy)

Sometimes the lights on the printer signal a problem.
= Both lights are off. To conserve energy, the printer turnsitself off if itsleft

idle for some time (usually about 5 minutes). If you suspect a problem,
press the power button. If the lights remain off, check to make sure the
power cord is plugged in properly and the outlet has power. If you carn't
turn the printer lights on, see the information about service and support
that comes with the printer.

The error light glows steadily. Either the printer is out of paper or the paper
has misfed. Check your computer screen for messages. See Chapter 2 for
instructions on loading the sheet feeder, or “ Paper |s Jammed” and “ Paper
or Envelopes Feed Improperly” later in this chapter.

The error light blinks. The ink cartridge may not be seated properly. Open the
printer's cover. Make sure the cartridge is inserted properly, and that the
bright blue lever isfirmly lowered to secure the cartridge in place. For
instructions, see “Installing the Ink Cartridge’ in Chapter 1



The printer seems slow
See the suggestions under “Speed” in Chapter 3

If you have a Macintosh I1fx, Macintosh Quadra 900, or Quadra 950
computer, check the Serial Switch control panel. Make sureiit is set to
Compatible

Note: The printer automatically takes a few moments to clean the print head
when it is plugged back in or after more than three days of inactivity.

Paper is jammed

Occasionally a piece of paper may get stuck inside the printer during the
printing process. To cdear a paper jam, follow these steps:

1  If necessary, open the printer to see where the jam is.

2 Gently pull the paper free.
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More than one piece of paper passes through the printer at a time

Follow these steps:

Remove all the paper from the sheet feeder.
Turn off the printer.

Turn the printer back on.

Put the paper back in.

Paper or envelopes feed improperly

Chapter 5

If paper tears, gets skewed, or comes through the printer crumpled, it may not
be entering the printer properly. Try the following:

= Make sure you have loaded the paper correctly, paying special attention to both
paper selectors.

For instructions on loading paper, see “Loading the Sheet Feeder” in
Chapter 2.

= Do not overload the sheet feeder.

The feeder holds up to 15 envelopes or up to 100 sheets of 20-pound paper.
If you use heavier paper, fewer sheets will fit in the feeder.

= Do not force paper into the sheet feeder.



= Try toremove any torn or damaged pieces of paper from the printer.

See “Paper Is Jammed,” earlier in this chapter.

= Take the paper out of the sheet feeder and check it.
Make sure none of the sheetsis curled, bent, or dog-eared.
Make sure the edges of the stack line up evenly.

Make sure the left paper guide ist too snug or too loose The stack should
lieflat (not bowed).

Make sure the paper doesnt dide down into the printer.
Load either envelopes or paper (not both) into the sheet feeder.

Make sure you have inserted envelopes correctly. The flaps should lie flat
against the envelope, the edges should be smoothed flat, and no air should
be trapped in the envelopes.

When loading back-print film, put a sheet of plain paper at the back of
the stack.

When loading transparencies, the shiny side should face you. The edge
where the paper and the transparency are joined should point downward.
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The Color StyleWriter 2500 won't print a particular document

If you attempt to print a document and no page is printed—not even a blank
one—try the following:

Check for messages on your Macintosh screen. Also, open the window for
your printer by double-clicking its desktop icon.

Your computer may be low on memory. See “Memory IsLow,” later in this
chapter.

Turn the printer off, then on again. (This resets the printer)
Repeat the printing process
Sometimes problems disappear when you try to print your document again.

Printing problems can often be caused by errorsin your programs If you
can print from the SmpleText or TeachText program but not from another
program, it's probably a problem with that program. Contact the publisher
of that program for help.

Restart your Macintosh.

The printer acts as if it's working, but nothing is printed on the page

Chapter 5

If your printer takes the paper, but doesnt actually print anything, try the
following:

If the ink cartridge is hew, make sure that you removed the orange tape
from its print head.

Make sure the ink cartridge and the ink tanks in the four-color cartridge
are correctly installed. (For instructions, see “Replacing Ink Tanks in the
Four-Color Ink Cartridge’ and “ Replacing the Ink Cartridge’ in Chapter 4).

The printer may be out of ink. You can check by seeing whether the test
page prints. To print atest page, see “ Checking the Print Nozzles’ in
Chapter 1



Messages appear on your computer screen

M ost messages that appear on your screen are self-explanatory. For example,
they may tell you that the printer is out of paper or that the paper is jammed.
Once you correct the problem, the message goes away.

Here are some other problems that on-screen messages might report:
Serial port in use by another application

Restart your computer before trying to print again.

The waste ink container in the printer is full.

From time to time, the printer deposits some ink into a waste container. In the
rare event that the container becomes full, Apple recommends that you take
the printer to an Apple-authorized service provider.

There is an error in the printer.

Check to make sure the cable is still connected to the printer and the
computer. Also, make sure the ink cartridge is seated properly. Turn on the
printer and open the printer's cover. Make sure the cartridge is inserted
properly, and that the blue lever on the side of the carrier isfirmly lowered to
secure the cartridge in place

The printer detects an end of paper error.

Make sure that you are using avalid size of paper, and that you indicate the
size in the Page Setup dialog box. Valid sizes for the Color StyleWriter 2500
are: U.S Letter, U.S Legal, A4 Letter, Executive, #6 envelopes, and #10
envelopes Other sizes may not work correctly.

No Paper or Wrong Paper Size

These messages usually mean what they say. Occasionally they appear when
you have the wrong port indicated in the Chooser. See “ Telling Your
Computer to Use the Color StyleWriter 2500” and “Special | nformation for
PowerBook Owners’ in Chapter 1

Memory is low.

See the next section.
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Memory is low

Chapter 5

Oncein awhile, your computer may be temporarily low on random-access
memory (RAM).

Symptoms that indicate a memory problem.

= Some documents do not print.

= Some text incorrectly appears in the Geneva font.

» Characters look jagged.

= An “out of memory” message appears on your screen.

If you have a memory problem, try the following:
= Run only one program at atime; quit the ones youre not using.

= If memory has been severely fragmented, you should quit all open
applications, then reopen just the one youre using.

= Increase the amount of memory you give to the program youre printing
from by using the Get Info command (as explained in the instructions that
came with your Macintosh).

= Turn off background printing. See “Printing While You Use Your
Computer” in Chapter 2.

= Inthe Page Setup dialog box, choose Portrait (normal) orientation instead
of Landscape (sideways) orientation.

= Dot print your documents with watermarks

= Choose “Black and White’ from the Image pop-up menu in the Print
dialog box. Printing in black and white takes the least memory.

= When you print in the background, if you often get a message that there is
not enough memory to print on a certain desktop printer, you can give that
desktop printer more memory by selecting itsicon and choos ng the Get
Info command. Then increase the number in the Preferred Size box. (For
more information on increasing a programs memory, see the
documentation that came with your Macintosh))

= Remove desktop printing. See Appendix F



= Turnon virtua memory in the Memory control panel. Virtual memory is
described in the instructions that came with your computer. (Note: Using
virtual memory can dow down your computer.)

= Aslong asthere are any print requests waiting to be printed, Desktop
PrintMonitor (the desktop printing software) remains active in memory;,
even when background printing is off. If you are not printing in the
background, you can remove all print requests from your desktop printer
gueues to reduce memory requirements by 160K.

= Obtaining additional RAM for your computer can solve some of these
problems and improve printing speed.

Documents did not print as expected

If the quality of printing is OK—not smeared or incomplete—but the result is
not as you expected, you may have made a mistake in using the printer
software. Check the subsections that follow for suggestions.

Text appears in the Geneva font or prints jagged

When your Macintosh computer is low on memory, it may display and print
certain fonts in the Geneva font. (Geneva Tooks 1ike this.) Some text may also
have jagged edges. To fix low-memory problems, see the preceding section,
“Memory Is Low”

If youre printing to a shared StyleWriter that is not directly connected to your
computer and you use Adobe™ Type Manager, the PostScript™ version of your
fonts must be installed on the computer that is directly connected to the
StyleWriter.

For more information about fonts, see Appendix B, “Using Fonts With the
Color StyleWriter 2500

Some rotated text may print jagged if you apply a style that has not been
defined for the font. Try applying plain style to the text.
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Text prints, but pictures do not

Some advanced page layout and art programs use the PostScript page
description language, a language that the Color StyleWriter 2500 does not
understand. If your programs have a PICT preview option, you can print the
file on a Color StyleWriter 2500.

Page breaks change unexpectedly

Most programs determine where to break pages by eval uating the information
you provide in the Page Setup dialog box. Also, different types of printers
gpace text in dightly different ways. The following actions can cause page
breaks to change:

= changing from one type of printer to another

» changing the page size in the Page Setup dialog box

= scaling the document in the Page Setup dialog box

» changing the orientation in the Page Setup dialog box

It's best to choose the printer you want and the Page Setup options you need
before working on your page breaks

A page prints off center

This problem may result from one of the following conditions:
= You have selected the wrong page size in the Page Setup dialog box.
= The margins are set incorrectly in the document you are printing.

= Paper is not placed properly in the sheet feeder. See “Paper or Envelopes
Feed Improperly” earlier in this chapter.

= You are not using recommended printing materials
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Text lines up in columns on the screen but not when it prints

You may have used spaces (rather than tabs) to line up the text. Because
printers interpret spaces differently than the screen does, the text may fail to
line up when you print it. Try replacing the spaces with tabs.

You can also make columns by using spaces with a monospace font—such as
Courier or Monaco—instead of tabs. A monospace font is one in which every
character has the same width.

Everything prints backwards

Choose the Print command and check what paper type youve selected in the
dialog box that opens. If you indicate that youre printing on back-print film,
the printer reverses the image

There are watermark problems
The wrong watermark printed.

If you selected one watermark, but a different one printed, you can fix it by
changing the modification date and time of one of the watermark files To
change the modification date, open one of the files, then save it using the Save
As command. (The watermark files are stored in the Printing Prefs folder,
which isin the Preferences folder inside the System Folder) When asked if
you want to replace the file, say yes.

| created a new watermark, but it doesn’t show up in the dialog box.
= Make sure the watermark was saved as a PICT or PICT2 file

= Make sure the file was saved in the Printing Prefs folder, which isin the
Preferences folder inside the System Folder.
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Print quality is poor

Chapter 5

Most image problems are caused by problems with an ink cartridge or with
your choice of paper. Dorit use the following types of paper:

= erasable typing paper

» damaged, wrinkled, or stapled paper

= Multipart forms (“carbonless carbons’)

= glossy paper, unlessits especially designed for StyleWriter printers

For best print quality, use coated or glossy paper or back-print film. If you
use plain paper, use 16- to 24-pound copier paper; 20-pound paper is
recommended. Plain papers can vary widely. If youre not happy with one
kind of paper, try adifferent brand.

Colors skip or streak at the bottom of the page

If youre not happy with the quality of printing near the bottom of a page,
change the setting for the bottom margin to 0.8 inch.



The image is too light or too dark

If printing looks fuzzy because it's too light or too dark, try the following:

» Check the nozzlesin the print head. See “Checking the Print Nozzles’ in
Chapter 1 for instructions. If this doesrit help, replace one or both ink
tanks in the four-color ink cartridge, or replace the black-only cartridge
See “Replacing Ink Tanks in the Four-Color Ink Cartridge’ and “Replacing
the Ink Cartridge’ in Chapter 4 for instructions.

= Make sure youve chosen the correct paper type in the Print dialog box.

= |f youreusing plain paper, try flipping the stack of paper in the paper tray.
Most paper has one side that's better for printing. If youre using other
material, make sure you have it loaded in the correct orientation. See
“Loading the Sheet Feeder” in Chapter 2.

= Try printing on a different kind of paper.
= Try choosing Best print quality in the Print dialog box.

= Make sure that both paper selectors (one inside the printer, the other on the
sheet feeder) are set to the correct position. See “Loading the Sheet
Feeder” in Chapter 2.

Thin lines fade or break up

Pick a darker color for the affected object, or try printing with the Pattern
halftoning option selected. (In the Print dialog box, click the Options button,
then dick the Pattern button)

The ink smears when rubbed

Dorit handle pages before the printer gjects them from the printer and
delivers them into the output tray. This allows all the time needed for the ink
to dry.

Pages leave the printer smeared, blurred, or smudged

The print head may be too close to the paper it's printing on. Move the
internal paper selector to the envelope (=) position. See “Loading the Sheet
Feeder” in Chapter 2.
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Printing appears on only part of the paper
Check the selections in the Page Setup dialog box.

Check the nozzles in the print head. See “ Checking the Print Nozzles’ in
Chapter 1 for instructions. If this doesrit help, replace one or more ink tanks
in the four-color ink cartridge, or replace the black cartridge See “Replacing
Ink Tanks in the Four-Color Ink Cartridge’ and “ Replacing the Ink Cartridge’
in Chapter 4 for instructions.

Colors don'’t ook right on the printed page

Try the following:

= Print atest page to seeif youve run out of ink. For instructions, see
“Checking the Print Nozzles' in Chapter 1

= Try printing the image with ColorSync turned on. For instructions, see
“Adjusting Color Options’ in Chapter 2.

= Use adifferent type of paper.

Unwanted horizontal white lines or stripes appear

Problems with print quality, especially horizontal white linesin your
document, may mean a nozzle on the print head is clogged or your ink
cartridge is running out of ink. There are two ways to solve the problem:

= Cleaning the print head is the faster method. It forces a nozzle cleaning as
part of aprint job. In other words, you can tell the printer to clean the print
head before it starts printing the next document.

» Printing atest page also cleans the print head. It gives you atest pattern
you can evaluate, but it takes a bit longer.

IMPORTANT Cleaning the print head consumes a small amount of ink. If you
repeat the procedure unnecessarily, you reduce the life of your cartridge.

Explanations of both procedures follow.



Cleaning the print head
To dean the print head, follow these steps:

When you are about to print a document, click Utilities in the Print dialog box.

Note: If the printer is being shared by using ColorShare, you must print the
document from the computer that is directly connected to the printer.

Color StylelWriter 2500

Copies: lil Pages: @ Al O From: To:

Print Quality: O Best (@ Normal () Draft
image:[_Color ]
Notification:_None |

Cancel

| Click this button.

The Utilities dialog box opens

Color StylelWriter 2500 Utilities

First, click to ] —L<] Clean ink cartridge before printing

place an X here.

| Then click OK.

The Utilities dialog box closes, and the Print dialog box reappears.

In the Print dialog box, click Print.

The printer deans the print head before printing your document.
Note: After the printer cleans the print head and prints your document, the

cleaning option is automatically turned off. You dorit have to turn it off before

printing again.
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Printing the test page
To print the test page, follow these steps:

Turn off the printer.

Make sure you've loaded U.S. letter-size or A4 paper into the printer.
Press and hold down the power button until the power light starts to blink.
Release the power button and wait for the test page to print.

Examine the nozzle test pattern for broken or missing horizontal lines.

The nozzle test pattern appears near the bottom of the test page The test
pattern for the four-color ink cartridge looks like this:

A broken line means a nozzle on A missing color means you need to

the print head needs to be cleaned. replace an ink tank (or the black-only cartridge).
Yellow

Magenta —— 3 : ; i |

Cyan

Back m—1—  +—+7 —t+—F—+—A4+—|+ | |

The test pattern for the black-only ink cartridge looks like this:

T o s o e S N T

If you see a broken line, try the following:

= |f you see amissing color, replace the ink tank containing the missing
color. (Or replace the black-only ink cartridge if that's what you used to
print the test page)

= If you see abroken ling, clean the print head. (For instructions, see the
previous section, “Cleaning the Print Head.”)



The image prints wavy or distorted

Make sure that you are using a recommended type of paper. Check the setting
of the internal paper selector above the ink cartridge If the problem persists,
see the information about service and support that comes with the printer.

Stains appear on printed pages

Stains on the backs or tops of printed pages may mean that ink has spilled
insde the printer. If so, the ink can transfer to the rollers and from there to
the paper.

Turn the printer off and unplug it. Then open the printer and carefully clean
the rollers and platen with a soft, dry cloth.

If necessary, you
can clean the rollers
and platen with a
soft, dry cloth.
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Ink tanks and cartridges run out of ink too quickly

Chapter 5

To extend the life of your ink cartridges, try the following:

Select Draft print quality in the Print dialog box whenever you can.
Dont clean the print head unless necessary.
Dont print solid background colors unless necessary.

Dort open the printer's cover unnecessarily. (After you shut the cover, the
printer deans the print head, which uses up ink.)

Dorit unplug the printer or otherwise discontinue power frequently.
Dorit print the test page unless necessary.

If you print mostly black and white documents, use the optional high-
performance black ink cartridge



Appendix A
Technical Information

General specifications

Marking engine

s Thermal ink jet engine

Resolution

The resolution differs according to the quality of printing you select. It is
expressed in horizontal by vertical dots per inch (dpi).

= Best: 720 x 360 dpi, with optimal ink density (automatically chosen for
the paper youve sel ected)

= Normal: 360 x 360 dpi
= Draft: 180 x 180 dpi
Engine speed

» Printing speed depends on the images printed and on the Macintosh
computer used.
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Connector cable

Apple System/Peripheral-8 cable

Interface

High-speed serial (RS-422)
Optional Local Talk
Optional EtherTalk

Fonts

TrueType font support

64 TrueType fonts available, congsting of the 43 that come with the
Color StyleWriter 2500 and the 21 that come with Macintosh system
software (see Appendix C for alist of available fonts)

Adobe PostScript font support when used with Adobe Type Manager
software (sold separately by Adobe Systems Incorporated)

Sheet feeder

Holds up to 100 sheets of 20-pound (75 grams/meter? ) paper or
15 envelopes.

Printing materials

Plain paper: Use 16-pound (60-g/m?) to 24-pound (90-g/m?) paper.
Accepts most |etterhead and colored stock.

Accepts medium-weight sheets of labels

Use #6 or #10 envelopes.

Apple recommends back-print film, transparency film, coated paper,
Premium Plus Coated Paper, and glossy paper especially designed for the
Color StyleWriter 2500 printer. See your Apple-authorized dealer.



Paper sizes in millimeters (mm) and inches (")

= US Letter: 2159 mm x 2794 mm (85" x 11")

s US Legal: 2159 mm x 3556 mm (85" x 14")

s A4 210 mm x 297 mm (83" x 11.7")

= Executive: 18415 mm x 266.7 mm (7.25" x 10.5")

s #6 envelopes: 1651 mm x 921 mm (6.5" x 3625")

= #10 envelopes: 241.3 mm x 1048 mm (95" x 4125")

Printable area in millimeters (mm) and inches (")
s Maximum printable line in portrait (normal) orientation: 206.0 mm (811")
s Minimum margins
Left and right: 3 mm (012")
Top: 3 mm (012")
Bottom: 8 mm (0.3")
Dimensions in millimeters (mm) and inches (")
= Height: 211 mm (8.3")
= Width: 365 mm (144")
= Depth: 234 mm (92")

Weight
» Approximately 32 kilograms (6.9 pounds)
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Operating environment
Temperature

= 15°to 30° C (59° to 86° F)
Relative humidity

= 10 percent to 80 percent, noncondensing

Storage environment

Temperature

s 0°t035° C(32°t095° F)

Humidity

= 5 percent to 95 percent, noncondensing

Power consumption

Operating
s 20 watts maximum

Power requirements for AC power adapter

The electrical requirements vary depending on the country for which your
model was manufactured

Power supply

= AC power adapter

92 ' Appendix A



Apple part numbers

If you have trouble finding any of the following products, the part numbers
may help you describe them to the dealer. Note, however, that part numbers
sometimes change as products are enhanced.

Replacement ink tanks for four-color ink cartridge
= Black ink tank: M3330G/A
= Color ink tank: M3329G/A

Ink cartridges
» Color ink cartridge: M3328G/A
» High-performance black ink cartridge: M3240G/A

Connector cable
= Apple System/Peripheral-8 cable: MO197LL

Printing materials

» Apple Color Ink-Jet Transparency Film, Letter-size: M2658G/A

= Apple Color Ink-Jet Transparency Film, A4-size: M1959G/A

= Apple Color Ink-Jet Premium Coated Paper, Letter-size: M2952G/A

» Apple Color Ink-Jet Premium Coated Paper, Ad-size: M2951G/A

» Apple Color Ink-Jet Premium Plus Coated Paper, Letter-size: M4792G/A
= Apple Color Ink-Jet Premium Plus Coated Paper, Ad-size: M4791G/A
» Apple Color Ink-Jet Glossy Paper, Letter-size: M3655G/A

= Apple Color Ink-Jet Glossy Paper, A4d-size: M3656G/A

» Apple Color Ink-Jet Back-Print Film, Letter-size: M2953G/A

= Apple Color Ink-Jet Back-Print Film, A4-size: M2954G/A

Technical Information
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Available Options
» Color StyleWriter Local Talk Module: M4615ZM
= StyleWriter EtherTalk Adapter
North America—style plug: M4775LL
Japan-style plug: M4775J
Continental Europe—style plug: M4775ZM
United Kingdom-style plug: M4775B
Audralia-style plug: M4775X
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Kinds of fonts

Appendix B
Using Fonts With the Color StyleWriter 2500

A font isacollection of letters, numbers, and symbols in a distinctive
typographic design. Your Macintosh computer and Color StyleWriter 2500
printer come with a variety of fonts that look great both on your monitor and

on paper.

Fonts come in such a variety of formats that problems can sometimes arise
This appendix provides the information you need to avoid such problems and
to solve them if they come up.

The Macintosh works with three main kinds of fonts: TrueType, bitmapped,
and PostScript fonts.

Apple provides two kinds of fonts with your Macintosh and the
Color StyleWriter 2500 printer: TrueType and bitmapped. However,
your system can use PostScript fonts as well when it has the proper
software installed.
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TrueType fonts

A TrueType font is scalable, describing a typeface without rigidly specifying a
size So it looks good whatever size you choose TrueType fonts provide sharp
text at any size on screen or on paper. You can mix and match TrueType fonts
from various font vendors

%

Courier

TrueType fonts store individual text characters as mathematical descriptions
of lines and curves, rather than as groups of pixels (a bitmap). When a
program asks for a character in a particular size, such as 33 points, the
Macintosh uses mathematical calculations to enlarge the character's outline
to 33 points and fill in the dots for the monitor or printer output.

Sometimes you |l still get jagged edges when you print a document, even
when you use a TrueType font. In nearly all cases, thisis because there isnt
enough memory available to scale the font properly for printing. This may
happen, for example, when youre running several programs at the same time.

Because you dorit need a separate font for each character size in order for
your printing to look good (as you do with bitmapped fonts), TrueType font
names dorit have numbers in them.

How does a font look? To see what a TrueType or bitmapped font looks like
on your screen, double-click the font'sicon to openit. A sample of that font
appears (in three sizes for TrueType fonts and in the size you opened for
bitmapped fonts).

El} Palatino =———5 EN}
-9 point - Sarmnple
Phwmz!orbaﬂk-im'wﬂﬂsﬂoﬁcaﬂ lowal =i pigqued How raluzorl'back-jumping f'lmgs car
= lewel six piqued gymnasts!

Palatino 12

- 12 point
Howr razorback-jurnping frogs can level
six piqued gyrnnasts!

- 18 point
How razorback-jumping
froge can level six piqued
gymnasts!

To use thiz font, drag it onto your Systern Folder

Tousze thiz font, drag it onto your Systern Folder




You can also use the Key Caps desk accessory to examine fonts See the
documentation that came with your computer for instructions

Bitmapped fonts

Bitmapped fonts consist of “pictures’ of atypeface at specific Szes For
example, you might have bitmapped fonts at 10-, 12-, and 18-point sizes
installed in your Macintosh computer. For best results you need a separate
font file for each size of character you want to use

The icon of a bitmapped font (also called a fixed-sze font or screen font) has
the single letter A on it. The font's point size appears at the end of its name

A

Monaco 12

When you request a bitmapped character, your Macintosh looks for an
installed bitmapped font in the size you specified. (See “How the Macintosh
Looks for Fonts’ later in this appendix) If it carit find that font, your
Macintosh tries to construct one by scaling a size that it does find.

In most cases, scaled bitmapped fonts dorit ook nearly as good as
preinstalled ones. Such scaling is one reason for the jagged edges (sometimes
called “jaggies’) you |l see on your screen or in a printed document when you
reguest an uninstalled size (for example, 17-point Geneva).

Bitmapped fonts are designed on grids of 72 dots per inch (dpi)—the
standard Macintosh screen resolution. Because of their correspondence to the
standard screen resolution, bitmapped fonts in preinstalled sizes always ook
great on your display.

When you print a bitmapped font, it prints at a resolution of 72 dpi. Because
most modern printers can print at resolutions far better than this (your
Color StyleWriter 2500 prints at 360 dpi or better), printed bitmapped fonts
amost always have jagged edges or stairstep sides.

Fortunately, the Macintosh can use bitmapped fonts in combination with
other font formats, reserving bitmaps for the screen and other kinds of fonts
for the printer.
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PostScript fonts

PostScript is a page-description language that defines the characters, symbols,
and images that appear on each page of a document. A PostScript font comes
asapair of fonts: an outline font for the printer and a corresponding
bitmapped font for displaying type on your screen.

No bitmapped font, no menu entry: If your system doesrit have the bitmapped
font, the PostScript font name wor't appear in your font menu.

Couri

Certain printers are designed specifically to work with PostScript fonts
While your Color StyleWriter 2500 is not a PostScript printer, it can use
PostScript fonts if you have Adobe Type Manager software installed. Adobe
Type Manager uses printer fonts to generate clean-looking screen text at any
size (This software is included with some installations of system software 7.5
It is available from your local Apple-authorized dealer for version 71)

IMPORTANT Adobe Type Manager is not an Apple product. It is made and
supported by Adobe Systems Incorporated. Only the version that comes with
Apple Macintosh system software version 75 is supported by Apple

PostScript printer fonts have no numbers associated with their names,
because a single font can be scaled to any size Many companies make
PostScript fonts; the following illustration shows icons for Adobe, Bitstream,
and Fontek PostScript fonts, plus a generic PostScript font icon.

Zl & [El &

QuickDraw GX imaging technology

A QuickDraw GX font is a TrueType or PostScript font with an additional set
of sophisticated features. These features include extremely accurate
typographic elements such as ligatures and kerning, plus the ability to skew,
rotate, and add perspective to text in extremely flexible ways.



How TrueType fonts work with other kinds of fonts

Although TrueType fonts offer distinct advantages, your Color StyleWriter
2500 printer can also use other kinds of fonts

TrueType and bitmapped fonts

Macintosh computers running System 7 come with both bitmapped (screen)
fonts and TrueType fonts installed. This maintains consistency with
documents created on Macintosh systems that don't have TrueType fonts.

S IE—"F—r———=— Courier =i —0F————715
123 iterns 142.2 ME in disk 29.7 MB available

Courier

Courier 9 Coupier 10 Courder 12 Courier 14 Courier 18

ik
<] E2E

Bitmapped fonts look better displayed on the monitor, while TrueType fonts
look better on a high-resolution printer such as the Color StyleWriter 2500.
So, if you have both versions of the font available, the Macintosh uses the
bitmapped version when displaying the font on the screen (provided that the
Szeyoure using is available) and the TrueType version when printing the font
on the Color StyleWriter 2500. To force the Macintosh to use only TrueType
fonts everywhere, you must remove the bitmapped fonts

For example, if adocument uses 12-point Times®, available in that sizeasa
bitmapped font and as a TrueType font, the system uses the bitmapped font on
the screen and the TrueType font on the printer. If a document uses 4-point
Times, the system scales the TrueType font to that size for both the screen and
the printer, because a bitmapped version isrt available

Using Fonts With the Color StyleWriter 2500
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Using only TrueType fonts produces a closer match between the appearance
of type on the screen and on paper. However, a document youve already
created with bitmapped fonts will be reformatted with the corresponding
TrueType fonts, and line breaks in the document may change Smilarly, if a
document is created on a system that has TrueType fonts or Adobe Type
Manager software installed, it may have different spacing, kerning, and so on,
when opened on a system that doesrit have TrueType fonts or Adobe Type
Manager software

Keeping two font versions available

If you have a TrueType version of afont, you dor't need a bitmapped version.
However, although keeping both versions of a font takes up more disk space,
there are several advantages to doing so.

Bitmapped fonts are hand-designed: a graphic artist planned each character
in each font to look good on a screen. TrueType fonts are scaled by the
computer to match what you request. At smaller point sizes, the bitmaps may
appear sharper.

Additionally, scaling fonts takes time—sometimes up to several secondsin
dower Macintosh computers—but all Macintosh computers can display a
bitmapped font instantly.

TrueType and PostScript fonts

PostScript fonts were designed as fonts for PostScript printers. The Color
StyleWriter 2500 wasrt designed to use PostScript. However, if you have
Adobe Type Manager software installed, your computer can both display and
print PostScript fonts

Use different names:. To avoid confusing the printer software, be sure that you
donit install both TrueType and PostScript versions of the same font. For
example, do not have a PostScript font file called Times and a TrueType font
file called Timesinstalled in your system at the same time.



How the Macintosh looks for fonts
Herés the search order your Macintosh uses to determine which font to
display on your screen when you choose a specific size:
1 aninstalled bitmapped font in that size, if one exists
2. ascaled TrueType font, if no bitmapped font exists

3 an Adobe Type Manager (ATM) version of a PostScript font, if ATM is
installed and if no TrueType version exists

4. ascaled bitmap if no ATM font exists

Herés the search order it uses to determine which font to print on your
Color StyleWriter 2500 printer:

1 ascaled TrueType font, if one exists

2. an ATM version of a PostScript font, if ATM isinstalled and if no
TrueType verson exists

3 ascaled 72-dpi bitmap if no ATM font exists
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Where fonts are stored

Appendix B

All fonts for your Color StyleWriter 2500 printer reside in special places
within the System Folder. To install fonts, you drag them to the System
Folder. Your Macintosh will automatically put them where they belong—in
the Fonts folder within the System Folder.

The Fonts folder can contain atotal of 128 font suitcases (described in the
next section), plus any number of PostScript fonts, up to the available storage
capacity of your hard disk.

S=——— Fmnls =————_"711=
Marng Size Kind i
=T =
HelwveMarObl 26K PostSeript™ font
Helvetica 4k font suitcase
HyperCharacters brap 12K fant suitcase
Londan 4k font suitcase
Loz Angeles 12K fant suitcaze
MerrionSquare brmap 8K font suitcase
é MerriSqu 24K PostSeript™ font
Mabile 12K font suitcase
Monaca SEK  font suitcaze
MT Extra 20K font suitcase
@ MTExt 12K PosztSeript™ fant
Mew York 8Bk font suitcase
[A] Falatine 296K fant suitcase
San Francizco 4K font suitcase
Symbal T2E  fant suitcase
Times 264K font suitcase
TirnezBol 26K PostSeript™ font 0
5]

IMPORTANT Fontsinstalled in other folders or in the top level of the System
Folder may not work correctly. Additionally, bitmapped and TrueType fonts
stored outside of suitcases may not work correctly.



Suitcases

A font suitcase is a special folder for collections of fonts.

A]

Courier

Suitcases provide a convenient way to organize fonts in the same font family.
For example, its agood ideato use a single suitcase (called Courier) for all
fonts in the Courier font family—all Courier roman fonts as well as fonts
with names like Courier Bold and Courier Oblique

Courier 24 10K font
| Courier Oblique 10 TE  font
| Courier Oblique 12 Tk font

E1=——=— Courier =———ogop1=
22 iterns 1421 ME in disk 29.8 MB availably
| Mame. Size Kind
|d Bl Courier BoldOblique 15 12K font ]
E Bl Courier BoldOblique 24 15K font
@ Courier S9K font
E Courier 9 SK font
[# courier (boid) S6K font
(4 courier 10 SK font
fA courier1z 8K fant
(A courier 14 6K font
fA courier 1@ T fant
Z
A
Z

43
G
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Combining suitcases: To merge all the fonts from one suitcase with another,
drag one suitcase on top of the other. All the fonts from the dragged suitcase
will go into the other, and the dragged suitcase will disappear.

Note: To avoid confusion, rename a font suitcase whenever you put more
fontsinto it. For example, if you decide to merge Helvetica, Helvetica Black,
and Helvetica Compressed, name the suitcase something like “Helvetica
Regular/Black/Condensed.”

A suitcase can also contain fonts from different font families, although you
should keep all fonts of the same family in the same suitcase All the fonts
will still appear in menus with their proper names.

You treat a suitcase as you would a folder. To open a suitcase, you double-
cick it. To add afont, you drag the font'sicon to the suitcase and drop it in.
To remove afont, you drag itsicon out of the suitcase

To create a font suitcase, duplicate an existing one and throw away its
contents. Then rename the suitcase as appropriate and drag whatever fonts
you want into it.

You cannot have more than 128 font suitcases in the Fonts folder.

Sze limits for suitcases: No matter how many fonts you have in asingle
suitcase, the Fonts folder counts the suitcase as a single unit. Therés no limit
to the number of fontsin a single suitcase, but the suitcase cannot be larger
than 16 megabytes.



Styled fonts

Most fonts that come with your Color LaserWriter 12/600 PS-J printer have
defined styles. For example, if you open the Bookman font (contained in a
suitcase in the Fonts folder, which isinside your System Folder), you see files
for bold and italic versions of the font.

E=———= Bookman =—F—"—115
14 items 58.4 ME in disk 16.6 ME available
i
Bookmnan Eoakrnan (bald)
Bookman (italic) Bookman (bold, italic)
]
] [[Ei

But fonts such as Chicago, Geneva, Monaco, and New York do not come with
defined styles. If you open the Chicago font suitcase, you see only one file

EM| Chicago g
[CI1 itern 524 MBindisk 165
i

Chicago

]
= =R

You can apply a style to a font like this by making a choice from the
appropriate menu (Fonts, Style, Format, or some similar menu, depending on
the application program). A font predesigned with a given style nearly always
looks better than a font with a computer-generated “derived” style

About style names: Predesigned styled fonts sometimes have names you may
not be familiar with. For example, roman refers to a font without styling, or
plain. Obliqueis similar to italic. Light, demi, and extra are different kinds

of bold.

Using Fonts With the Color StyleWriter 2500
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Common questions about fonts

Appendix B

Here are some questions that often come up about fonts
What kind of fonts should | buy?

Using a font that has both bitmapped and TrueType versions works best. The
bitmapped version looks great on the screen and the TrueType fonts print
beautifully on the Color StyleWriter 2500.

Avoid bitmapped fonts that don't have TrueType versions because they print
with jagged edges on the Color StyleWriter 2500. By contrast, TrueType fonts
work well, even if you dorit have a bitmapped version.

If you have a PostScript printer or Adobe Type Manager, PostScript fonts
look great on paper. The Color StyleWriter 2500 is not a PostScript printer.

People who need professional typographic features such as swash characters
and proportional space numerals might also consider using QuickDraw GX
and QuickDraw GX TrueType fonts.

Why don't all of my fonts appear in the Fonts menu?

You may not have all of your fonts placed correctly. All the fonts should be
installed in the Fonts folder in the System Folder.

Additionally, some application programs let the user decide which fonts
should appear in the Fonts menu. Check the manuals that came with your
programs.

Why can’t | see my Monaco 9, Geneva 9 and 12, and Chicago 12 bitmapped fonts?

These fonts are used by your Macintosh to display information. Because the
M acintosh needs these fonts, the Finder makes them invisible to prevent users
from removing them.



What does the term Apple classic fonts mean?

The Apple classic fonts are the original ten bitmapped fonts that came with
the first Macintosh in 1984. These fonts, which all have city names, include
Athens, Cairo (a picture font), Chicago, Geneva, London, Los Angeles,
Monaco, New York, San Francisco, and Venice Several of the fonts (Athens,
Cairo, London, and San Francisco) came in only one size—18 points

This is a sample of Athens.
B @ @ /O m® @

This is a sample of Chicago.
This is a sample of Geneva.

This is a sample of Tondon.
Thiz is a sample of Los Angeles.

This is o sample of Monaco.

This iz a sampls of New York.

Thi} i} a vample of Ban Franeciico.

This is a sample of Venice.

Chicago, Geneva, Monaco, and New York are currently available in TrueType
versons. The other classic fonts are still only available in bitmapped versions.

Why do | sometimes get Geneva or Courier in my printed documents when I have
specified other fonts?

Geneva sometimes appears when youire trying to use a TrueType font but
dorit have enough memory for scaling to operate properly.

Substitute fonts can also appear in a document composed on one Macintosh
that has a particular set of fonts but printed on another Macintosh that doesrit
have those fonts

Why does a document written entirely in Times look different on different Macintosh
computers?

Times, an extremely popular font, is manufactured and sold by more than one
company. Such fonts usually have small differences, even though they have the
same name. For example, the Times font manufactured by Adobe Systems
Incorporated, has different letterspacing than does the Times font from Apple
Computer, Inc.

Using Fonts With the Color StyleWriter 2500
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What is font substitution?

Font Substitution, which isrit available for your Color StyleWriter 2500
printer, is an option in the Page Setup dialog box for certain PostScript
printers. When font substitution is turned on, these printers will use their
built-in equivalents for three bitmapped fonts (Times for New York, Helvetica
for Geneva, and Courier for Monaco).

What's a downloadable font?

A downloadable font is a TrueType or PostScript font sent to some kinds of
printers, such as most PostScript Laser printers, by your system software The
printer then uses the font to print your document.

If aprinter has sufficient memory, it can hold more than one downloaded
font; otherwise it must request the fonts it needs as necessary. This can be a
time-consuming process

Some printers have hard disks attached to them for holding downloaded fonts
A printer can get the fonts from its hard disk more quickly than it can
download them from the computer's hard disk.

Your Color StyleWriter 2500 printer cannot receive downloaded fonts.
Instead, your Macintosh composes the entire image and then sends it to your
Color StyleWriter 2500 for printing.



Appendix C
Font List

Between the fonts that come with your Macintosh and those that come with
the printer, there are 28 font families (and 64 total styled fonts) available as
soon as you install the Color StyleWriter 2500 software.

Name in Font menu

Avant Garde

Bookman

Chicago

Courier

DELPHIAN

Garamond Narrow

Geneva

Helvetica

Helvetica Black

Helvetica Compressed

Number of fonts

4

Font family (and styled fonts)

ITC Avant Garde®
(plain, italic, bold, and bold-italic)

ITC Bookman®
(plain, italic, bold, and bold-italic)

Chicago

Courier
(plain, italic, bold, and bold-italic)

Delphian

ITC Garamond® Narrow

(plain, italic, bold, and bold-italic)
Geneva

Helvetica®
(plain, italic, bold, and bold-italic)

Helvetica Black
(plain and italic)

Helvetica Compressed
(plain and italic)

Comes with

Color
StyleWriter 2500

Color
StyleWriter 2500

Macintosh

Macintosh

Color
StyleWriter 2500

Color
StyleWriter 2500

Macintosh

Macintosh

Color
StyleWriter 2500

Color
StyleWriter 2500

continues »
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Name in Font menu

Lubalin Graph
Lucida Bright
MAGHINE

Monaco

N Helvetica Narrow

Nadianne
New Century
Schoolbook

New York
Oy €English Text

Onyx

Oxrord

Palatino

Swing

SyuBoi (Symbol)
Times

Zapf Chancery
ke kO EVA
(Zapf Dingbats)

Z3% 4 % (Zeal)

Total

Number of fonts

4

64

Font family (and styled fonts)

ITC Lubalin Graph®
(plain, italic, bold, and bold-italic)

Lucida Bright
(plain, italic, bold, and bold-italic)

ITC Machine®

Monaco

Helvetica Narrow
(plain, italic, bold, and bold-italic)

Nadianne
(plain and bold)

New Century Schoolbook
(plain, italic, bold, and bold-italic)

New York
Old English Text

Onyx

Oxford

Palatino®

(plain, italic, bold, and bold-italic)
Swing

Symbol

Times®

(plain, italic, bold, and bold-italic)
ITC Zapf Chancery®

ITC Zapf Dingbats®

Zeal

Comes with

Color
StyleWriter 2500

Color
StyleWriter 2500

Color
StyleWriter 2500

Macintosh

Color
StyleWriter 2500

Color
StyleWriter 2500

Color
StyleWriter 2500

Macintosh

Color
StyleWriter 2500

Color
StyleWriter 2500

Color
StyleWriter 2500

Macintosh

Color
StyleWriter 2500

Macintosh

Macintosh

Color
StyleWriter 2500

Color
StyleWriter 2500

Color
StyleWriter 2500



Appendix D
Working With ColorSync

The Macintosh does alot of work to make sure that the colors you see on
your display dosely match the colors you get on your printers, scanners, and
other devices The software that does this work is called ColorSync. Because
ColorSync does its work behind the scenes, you dort have to know anything
about it. But if youre curious, this appendix explains how ColorSync works
and how you can benefit from using it.

The problem that ColorSync solves

Providing consistent color with desktop computersis atechnical challenge
Reproducing colors consistently from device to device is difficult because the
colored light on your monitor is very different from printed ink. Different
color devices use different methods for representing color information and
produce different ranges of colors.

Monitors (and most scanners) produce colors by mixing red, green, and blue
light—called RGB color. Most printers produce colors by mixing cyan (a
shade of blue), magenta (a bright pink), yellow, and black ink. This color
system is called CMY K. Since monitors and printers have different color
capabilities, they cannot reproduce each other’s colors exactly.

I'n addition, no two monitors or printers produce exactly the same colors.
(You can see an example of the differences among monitors at a consumer
electronics store, in the section that sells television sets)
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About ColorSync

ColorSync is a system extension that provides color-conversion capabilities
and improves color consistency. ColorSync “trandates’ the colors used on one
device s0 that they match the colors displayed or printed on another device

ColorSync color conversion is a central part of Macintosh computing, ensuring
that applications, monitors, printers, scanners, and digital cameras use the
same scheme for color conversion. This means you can scan an image, display
it on your monitor, and print it—with visually matching colors every step of
the way.

How ColorSync works

E Appendix D

ColorSync does not convert colors directly from one device to another.
Instead, ColorSync takes information about each devices color capabilities
and compares it to an independent color standard. In this way, it converts the
colors produced on one device to closely matching colors that can be
reproduced on another device

Monitor ColorSync profile CIE color standard ColorSync profile Printer
..... . ;,j....._....,m e ;,j.....,
— |

1 ColorSync checks 2 ColorSync translates 3If a device can't
a device’s ColorSync device-specific colors reproduce a standard
profile for the device’s to standard colors, which color, ColorSync

color capabilities. are not limited by chooses the device’s

the color capabilities closest match.
of any device.

ColorSync defines the colors a monitor, printer, scanner, or digital camera can
reproduce in a ColorSync profile. ColorSync profiles are compatible with the
profile specifications of the International Color Consortium (ICC).



Next, ColorSync converts device-specific colors into standard colors. The CIE
color standard describes colors in terms of how they are perceived by the
human eye under standardized lighting conditions. (CI E stands for the
Commission International de I' Eclairage, the International Commission on
[lumi nation, which founded the standard in 193L)

To maintain consistency, ColorSync previews a devices color capabilities (in
the ColorSync profile) and—where necessary—converts standard colors to
closely matching colors that the device can reproduce For example, your
monitor may be able to display avivid red, but your printer inks may not be
able to produce that color. ColorSync determines the “next best” color for
your printer to use

Using ColorSync

The ColorSync profile for adevice is automatically installed as part of the
devicés software To get the best visual color matching on your system, make
sure the following display settings are selected:

= For the best color match when printing, select the “page-white’ or “D50"
system profile for your type of display in the ColorSync System Profile
control panel.

» For the best visual match between the colors on your display and printed
colors, select the Page-White Gamma option in the Monitors control panel.
To select a gamma option, open the Monitors control panel, then hold
down the Option key while you dick the Options button. In the Options
window, click the Use Special Gamma checkbox to put acheck init. Then
choose Page-White Gamma from the menu.

= On amultiple scan display, make sure that the color temperature, or
intensity, is set to 9300 K (the default setting). See the display manual for
instructions. If the Page-White Gamma option is selected with a color
temperature other than 9300 K, your monitor colors could look too red or
too blue compared to printed colors.

Some color devices allow you to set additional color options that affect the
way ColorSync converts colors See the instructions that came with the device
for more information.
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Printing with QuickDraw GX

This appendix explains how to use the QuickDraw GX software with the

Color StyleWriter 2500. (If you installed QuickDraw GX after you set up your

printer, you must reinstall the Color StyleWriter 2500 software)

Telling your computer to use the Color StyleWriter 2500 with QuickDraw GX

Make sure the printer and your computer are connected and turned on.

Select the Chooser from the Apple (&) menu.

In the Chooser dialog box, use the “Connect via” pop-up menu to choose the

appropriate type of connection.

EE=———————— Chooser

AppleShare

Lasertfriter 300 GX  Lasertriter GX [

AppleTalk £Zones:

Halftime

Hardware Test Lab
Imaging

Instructional Products
Japan

Maontana

Second Floor

Third Floor

[ TI JUEHE -~ Serial —I
Servers
prleTaIkJ

2]
[ireate | [Rensme)
) Active
AppleTalk ) Inactive

If the printer is connected
directly to your Macintosh
with a serial cable,
choose Serial.

If the printer is connected to
a Macintosh on the network
and is available as a shared
device, choose Servers.

If the printer is connected to
the AppleTalk network,
choose AppleTalk.

Note: If QuickDraw GX isinstalled on your Macintosh, background printing
is always on and cannot be turned off.
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First, click this icon.

In the Chooser dialog box, click items to select them.

Some Chooser features change, depending on the selection you madein
step 2. If you chose Serial in step 2, the Chooser looks like this:

Chooser==rccaF7——-—"+—"——|
Connect via: Serial - SECOHd, C”Ck one Of

it these items to indicate

which port you connected the

El

2

AppleShare

(If you don't see the
icon, use the scroll bar
and arrows to find it.)

First, click this icon.
(If you don't see the
icon, use the scroll bar
and arrows to find it.)

Second, if your |

network has zones,
click the one
you want.
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Modem Port

printer to: the modem port or
the printer port.

Laserwriter 300 Gx  LaserWriter GX

AppleTalk Zones:

Halftime Printer Port

Hard Test Lab :

Ir:gg\i’\;agre . | — = Finally, to create a desktop
Instructional Products i printer, click Create. A printer
Jopan (create |  (Bename] icon appears on your

Secand Floar ® fotive desktop for easy access.
Third Floor AppleTalk O Inactive

If no port is available and your computer is a PowerBook, see “ Special
Information for PowerBook Owners’ in the section “ Telling Your Computer
to Use the Color StyleWriter 2500” in Chapter 1

If you chose Servers or AppleTalk, the Chooser looks like this:

Chooser

Connect via: Servers hd

_ Third, click the name of
Color Stylewriter 2500 GX < .
0 the printer you want to use.

El

aAppleShare

Don’s Printer
Osman’s CSw 2900 GX
Rick’s Printer
Steve’s Color Printer

Laserifriter Gr

Lesertiviter 300 GX Finally, to create a desktop
printer, click Create. A printer

icon appears on your

AppleTalk Zones:

Halftime

Hardware Test Lab desktop for easy access.
Imaging | |
Instructional Products ] . .

Japan [[ Create ]] [?%ezmzzze]—— If the prlnter is connected by
rs‘lontagaﬂ AppleTalk, you can rename
econd Floar i ; ; i
Third Floor 1 AppleTalk gfn‘;tc‘;ie the printer. (Otherwise, this

feature is not available.)




4 Close the Chooser dialog box.

If you close the Chooser without creating at |east one desktop printer, this
message appears.

You are about to close the Chooser
0 without creating a desktop printer.

Would you like a desktop printer to be

created for the last printer you

selected?

To use a printer for which you have no desktop icon, you must select the
printer in the Chooser and dick Create If you select the printer but dort
cick Create the Chooser ignores the selection.

Defining the page setup

Most Macintosh programs have a Page Setup command in the File menu. You
can use this command to set a variety of options The most common options
are already selected for you, but you can change them if you want to.

1  Choose Page Setup from the File menu.

The Page Setup dialog box appears, as shown in the next step. The dialog box
you see may hot exactly match any of theillustrationsin step 2, but it works
basically the same way.

2 Inthedialog box, make the selections you want.

If youre working in a program that doesn't take full advantage of QuickDraw
GX (isnot “GX-savvy”), adialog box similar to the one below appears.

Use this pop-up menu to identify the
paper or envelope size you are using.

Color StylelWriter 2500 GH Page Setup m

Page Size: [ US Letter -] Cancel

scaling {?«L]:E} To enlarge or reduce the
size of the printed image,

Orientation: choose from this pop-up

menu. (Or you can type a
number.)

For vertical orientation (also | | For horizontal orientation
called portrait), click here. (also called landscape), click here.
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For vertical
orientation (also
called portrait),

click here.

To see the expanded |

dialog box, click
More Choices.

To see the basic
dialog box, click
Fewer Choices.

3

Appendix E

If you are usng a GX-savvy program, there are two versions of the Page

Setup dialog box. Thisisthe basic version:

Page Setus ===—=———2 s this pop-up menu to identify the
Paper Type: |__ paper or envelope size you are using.
Orientation: I - -
For horizontal orientation (al II
scate: (ION] /ac;7dsocau§)e)t,a clci)ckeo:]?at gf tﬁlizg Eﬁttf)?ws,
depending on whether you want the top of

the image to be on the left or the right.

To enlarge or reduce the size of the printed

image, select this box and enter a number.

In the expanded dialog box, you can select a specific printer.

Page Setup

o>

Paper Type: Us Letter -

Orientation:
Scale: %

To format a document for
one of the desktop printers
you've created, choose
the printer from this

Format for: [ Color S 2500 GH

~] pop-up menu.

| Fewer Choices

When you've made your choices, click Format (or OK in a program that’s not GX-savvy).

Your document is now set up for printing.



Printing a document

To print a document, follow these steps:

1  Openthe document you want to print, or select its icon in the Finder.
2 Choose Print from the File menu.
A dialog box appears, displaying a number of printing options. The dialog
box you see may not exactly match any of theillustrationsin step 3 but it
works basically the same way. The most common options are already set
for you.
3 Setany options you like.
If youre working in a program that isnit GX-savvy, a Print dialog box similar
to the one below appears.
Color StylelWriter 2500 GH mﬁwint
) Copies: Iil Pages: @ Al O From: To: [ Cancel ]
.C“Ck Best TOF_ - Print Quality: C Best ® Wormal CDraft
highest quality, Paper Type: [ Plain______+|
Normal for typical use, Image: [ Color____+]

or Draft for lower ink
consumption. For plain
and coated paper,

you can use any of
these three choices;
for other materials, you
must use Best quality.

Choose Color, Grayscale, Use this pop-up menu to identify the type
or Black & White from of material you've loaded into the printer.
this pop-up menu. (For labels and envelopes, choose Plain.)

Printing With QuickDraw GX
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If you are usng a GX-savvy program, there are two versions of the Print
dialog box. Thisisthe basic version:

Print

To see the expanded
dialog box, click
More Choices. |

Print to: | Color SW 2500 G |7

Pages: @ Rl
) From: | | To: | |
Copies: _I

|__ To identify the desktop printer
you want, use this pop-up menu.

In the expanded dialog box, you can make additional choices.

Print

To display a dialog
box that lets you
schedule print jobs,
click this icon.

The paper-matching

Print Tirne

feature is useful for

Faper Match

3

Pages: @ All

Copies:

Fewer Choices

Print to: [ Color SW 2500 GH v |

) From: |

| To:| |

Use the Quality pop-up menu

Paper Feed: @ Automatic

) Manual

Destination: Quality:

printers that have

[< Collate Copies

to choose Best for highest

quality, Normal for typical

use, or Draft for lower ink
| consumption.

Note: If the printer is printing
on back-print film, glossy

multiple paper trays.

To see the basic dialog
box, click Fewer Choices.

paper, or transparencies,
choose Best.

4 When you are satisfied with the settings, click Print.

Appendix E

If necessary, the printer turnsitself on and, after afew moments, begins
printing your document. Dort open the printer cover while the document is
printing. (This can waste ink and cause a paper jam,)



Adjusting quality options
To adjust the way colors are printed, follow these steps:
1 Choose Print from the File menu.
2 Make sure the expanded dialog box appears.
If necessary, click More Choices

3 Inthe expanded dialog box, click the Quality icon and set any options you like.

Use this pop-up menu to identify the type

of material you've loaded into the printer. Choose Color, Grayscale, or
(For labels and envelopes, choose Plain.) Black & White from this pop-up menu.
e~
[ Color StylelWriter Quality Options
The printer blends the
_ Faper st Paper Tuoe: four ink colors in either
To see the quality perTupe: a random scattering of
options, click this icon. gg, Image: ‘ dots or a repeating patiemn
. (lf you dhOH t SEﬁ E)he e Halftoning Dptions: (?) Pattern (i) Scatter of dots. Choose the method
icon, use the scroll bar you prefer.
and arrows to find it.)
Fewer Choices

4 When you are satisfied with the settings, click Print.

If necessary, the printer turnsitself on and, after a few moments, begins
printing your document. Dot open the printer cover while the document is
printing. (This can waste ink and cause a paper jam.)

If you are still not happy with the quality, try using the regular (non-GX)
QuickDraw printing software and see which results you prefer. See “If You
Choose Not to Use QuickDraw GX Printing” at the end of this appendix.

Note: If you have a color PowerBook computer, open the ColorSync control
panel and make sure the system profile is correct for your PowerBook.

If it's not, choose Set System Profile from the pop-up menu and select the
correct profile
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Cleaning the print head

1

First, to see the
utilities, click this icon.
(If you don't see the
icon, use the scroll bar
and arrows to find it.)

To clean the print head, follow these steps:

When you are about to print a document, click Utilities in the expanded Print dialog box.

Print

E Color Stylellriter Utilities

Second, click to

[ﬁ Clean the print head before printing place an X here.
@ Clean

() Super Clean (Use only as a last resort)

Fewer Choices

When you are satisfied with the settings, click Print.

If necessary, the printer turnsitself on and, after a few moments, begins
printing your document. Dot open the printer cover while the document is
printing. (This can waste ink and cause a paper jam.)

Note: After the printer cleans the print head and prints your document, the
cleaning option is automatically turned off. You dorit have to turn it off before
printing again.

A printing shortcut

Appendix E

If you have one or more printer icons on your desktop, you can print a
document by dragging its icon to the printer.

For instructions on creating a desktop printer, see “Telling Your Computer to
Use the Color StyleWriter 2500 with QuickDraw GX” at the beginning of
this appendix.



If you choose not to use QuickDraw GX printing

If youre unhappy with the quality of color printing on your Color StyleWriter
2500, try turning off the QuickDraw GX printing software and using the
regular QuickDraw printing software You can decide which you prefer.

1  Open aprogram that’s not GX-savvy.

If youre not sure whether the program is GX-savvy, choose Page Setup from
the File menu. If the dialog box that appears looks like the one below, the
program is not able to take full advantage of QuickDraw GX.

The GX-savvy version of
the Page Setup dialog box
Page Size: [_US Letter ¥]  [cancel] [ contains additional

scating (%): [[IT][x] features.

Orientation:

Color Stylellriter 2500 GH Page Setup m

2 Choose Turn Desktop Printing Off from the Apple (&) menu.

A message appears.

Click OK to use the “Color SW} 26007 driver for
printing from this application.

To continue using desktop printing from this

application, click Cancel.

Note: If the message doesrit mention the Color SW 2500 driver, someone
may have removed it from your Macintosh. Use the Custom Install optionin
the Installer to install the driver. (See “Usi ng the Custom Installer to Solve
Installation Problems’ in the section *Installation Is Unsuccessful” in
Chapter 5)

3 Click OK.

Now your Color StyleWriter 2500 will use the regular QuickDraw printing
software. If you want to go back to using the QuickDraw GX printing
software, repeat this process, but in step 2 choose Turn Desktop Printing On.
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Appendix F
Removing the Desktop Printing Software

The printing software that you installed in Chapter 1 requires that you have at
least one printer icon on your desktop. If you don't want to use the desktop
printing software, you must remove the desktop printing software, as shown in
these steps:

Before you begin Find the disks that came with the Color StyleWriter 2500.
1 Insert Color StyleWriter 2500 Disk 1 into a floppy disk drive.

If necessary, open the disk icon.
2  To start the Installer program, double-click its icon.

3 Inthe Welcome dialog box that appears, click Continue.

125



126

4

In the Installer dialog box, choose Custom Remove.

Install Color SIJ 2500

Choose Custom __|
Remove from this
pop-up menu.

«~ Easy Install
Custom Install
Custom Remove
Color StylelWlriter 2500 Software
------ Destination Disk
fient fsk
—
our Hard Disk I Install I
[

5

First, click this

In the Custom Remove dialog box, click the Desktop Printing Software checkbox.

checkbox. (An X
appears to show it's
selected.)

Appendix F

Install Color SWWJ 2500 HE
[ Custom Remove |
Check featuresz to be removed
] QuickDraw Printer Software (2 |4
[<] Desktop Printing Software [E]
[ GH Printer Software [E]
[ Serial Switch for Mac |14, Quadra 900 and 950
[ ColorSync™ 2.0 Software
> [J TrueType Fonts
[
Drisk zpace available: 13 162K Selected size: 1 030K
------ Destination Disk Fma”y’ when you're
Eipet ek LTI ready to begin, click
:lHDBD Sesiioh Brek m_ Remove.
[

Second, make sure the disk named here is the one
from which you want to remove the desktop printing
software. (If not, click Switch Disk until the correct
name appears.)



When you see a message on your screen, follow the directions and insert the next disk.

The Installer gects disks and asks you to insert others. Keep following the
instructions on the screen until the process is complete

When you see a message reporting that the process was successful, click Restart.

The Installer restarts your Macintosh. When the computer restarts, the
desktop printer icons appear with an X on them.

After the computer restarts, drag your old desktop printer icons to the Trash.

Read the next section to learn how to use the PrintMonitor to monitor and control print
requests.

Removing the Desktop Printing Software
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Monitoring and controlling print requests without desktop printers

If you don't have desktop printers, you must use the PrintMonitor program to
monitor and control background printing.

1  While your document is printing, choose PrintMonitor from the Application menu at the
far right of the menu bar.
¥

Hide Simplelext
Hide Others

Finder PrintMonitor is available only when
e background printing is on.
v 42 SimpleTexnt . If you turn off background printing,
messages on your screen keep you
informed of printing status.

2 Inthe PrintMonitor dialog box, review the status of documents that are printing (and
make any changes you want).

E[[=———=— PrintMonitor

Printing
The document that's | Mermo anne’s Printer
currently printing Waiting
appears here. | (= Letter @ Suzanne’s Printer —I ks Documents that are waiting
to print are listed here.
To cancel the current J ||
print request, &

click here. ———{cancel Printing | (“setprint Time... —— To schedule a specific time for a
Printing Status: Memo document to print, click its name in

LPages To Print: 2 the list, then click Set Print Time.

Comments about 11% Complete Imaging Page *1
the status of the
document being
printed appear here.

You can remove a document that is waiting to print by clicking its name, then
cicking the Remove From List button that appears.

3 When you finish, click the PrintMonitor close box.
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Appendix G
Packing and Moving the Printer

If you need to move the Color StyleWriter 2500 printer along distance,
follow these steps.

1 Turn off the printer and unplug it.

N

Remove the power cord and serial cable.
3 Open the printer’s front cover.

4 Leavetheink cartridge in the printer, and apply a piece of tape to hold the cartridge in
place.
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5  Closethe cover.

6  Remove any paper from the sheet feeder.

7 Push the paper support and output tray back inside the printer.
8  Repack the printer in its original packing material.

When the printer arrives at its new location, unpack it and set it up as
described in Chapter 1
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Index

A

A4 paper 13,91
AC power adapter 3, 92
Adobe PostScript font icon 98
Adobe Type Manager 79, 98, 100, 106
alcohol-based or ammonia-based
cleaners 2, 63
alias for adesktop printer icon,
creating 40
Align Top Left watermark scaling
option 35, 36
Apple-authorized deal er/service provider
obtaining ink cartridges
and supplies 58
purchasing new system software or
memory 15
repair assistance 65
waste ink container isfull 77
Appleclassic fonts 107
Apple menu, Turn Desktop Printing
Off 123
Apple part numberslist 93-94
Apple System/Peripheral-8 cable
3,90, 93
AppleTalk network, sharing the printer
44-46
Application menu, PrintMonitor
command 128
audio alert of print completion 30

B

background printing
low memory and 78, 79
monitoring and controlling 42—43
PrintMonitor and 128
QuickDraw GX and 115
turning on or off 41
working with 28, 31
back-print film
backwards printing and 81
loading into the sheet feeder 26,
51,75
print quality setting for 120
tipsfor using 51
Best print quality option 30, 52, 119, 120
bitmapped font icon 97
bitmapped fonts
Appleclassic fonts 107
described 97
PostScript and 98
TrueType and 99-100, 106
Bitstream PostScript font icon 98
black ink cartridge
printing speed and 53
vs. color ink cartridge 4
when to replace 58
borders around mini pages 29, 37
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Index

cables
Apple System/Peripheral-8 3, 90, 93
checking connections 70
LocaTak 11
network 11
serial 11
“carbonless carbon” paper 49, 82
carrier
handling of 7-8, 10
replacing the ink cartridge and 59, 61
Centered watermark scaling option
35, 36
changing the order of itemsto print,
background printing and 43
Chooser
changing the default printer 39
selecting the printer 17, 28
setting up the printer for network use
45-46
setting up the printer for QuickDraw
GX 115117
turning background printing on or
off 41
user instructions for a shared
printer 47
Chooser dialog box 17, 115-117
CIE color standard 113
cleaning
the printer 2, 63, 87
the print head 30, 84-85, 122
CMYK color system 111
coated paper 26, 50, 119
color ink cartridge
vs. black ink cartridge 4
when to replace 58
color matching, turning on 32-33
color options, adjusting 30, 32—33
Color Options dialog box 32-33, 52
color printing
quirks 33
troubleshooting 82, 84

ColorShare 42, 44, 85
Color StyleWriter 2500 Disk 1 14,
68, 125
Color StyleWriter 2500 icon 16, 17,
31, 66
Color StyleWriter 2500 Log file 46
Color SW 2500-Troubleshooting file
19-20. See also test page
ColorSync
control panel 32, 113, 121
described 111-113
profiles 32, 112, 113, 121
turning on 32-33, 52
columns, printing, troubleshooting 81
connecting the printer
touse onaLocal Talk or EtherTalk
network 48
to use on an AppleTak network
44-46
to use with QuickDraw GX 115-117
to your Macintosh 11
Connect via pop-up menu (Chooser
dialog box) 115-116
controlling print requests. See monitoring
and controlling print requests
control panels
ColorSync System Profile 32,
113,121
Monitors 113
copies, selecting number to print 30
cost of printing, reducing 53
creating a desktop printer icon 40
Custom Install dialog box 69
Custom Install option 16, 6869
Custom Remove dialog box 126
Custom Remove option 126-127



D

damaged paper 49, 74-75, 82
default desktop printer icon 38, 40
default printer, changing 38-39
deleting a print request, background
printing and 42
density of watermarks 35, 36
desktop printer
creating 17, 40, 116
formatting a document for,
QuickDraw GX 118
desktop printer icons
appearance after removing desktop
printer software 127
creating, throwing away, or
manipulating 40
examples of 16, 31
troubleshooting 71
desktop printing 31
low memory and 78
turning off QuickDraw GX 123
desktop printing software, removing
125-127
Desktop PrintMonitor 79
dialog boxes
Chooser 17, 115-117
Color Options 32—-33, 52
Custom Install 69
Custom Remove 126
Installer 15, 68, 126
Page Setup 19, 29, 37, 80, 117
Page Setup, expanded QuickDraw GX
version 118
Print 20, 30, 52, 85, 119
Print, expanded QuickDraw GX
version 120-122
PrintMonitor 128
Setup 45
Utilities 85
Watermark Options 35
dimensions of printer 91
disabled (X) desktop printer icon 40,
71, 127

disconnecting the printer. See unplugging
the printer

disks, locking 14

display fonts 106

distorted print output, troubleshooting 87

document icon 31

downloadable fonts 108

Draft print quality option 30, 53,
119, 120

E

electromagnetic interference 4
energy-saving feature 6
engine specifications of the printer 89
enlarging the printed image. See scaling
envelopeicon 24, 25
envelopes
feed improperly 74-75
formatting the text for 26, 27
loading into the sheet feeder 24, 75
setting the paper selectorsfor 24, 25
typesto use 26, 77, 90, 91
environment specifications 92
erasable typing paper 49, 82
error light 6, 21, 72
error messages 70, 77
EtherTalk network, connecting the
printer to 48
extensions, turning off 14
external paper selector lever 13, 24

features of the printer, overview ix
File menu
Page Setup command 19, 23, 29,
34-37, 117118
Print command 20, 27-28, 30-33, 38,
119122
Quit command 20
Save command 33

Index -«
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Index

filling the sheet feeder. See loading the
sheet feeder
fixed-size fonts 97
folders
Fonts 67, 102, 106
font suitcases 103-104
Printing Prefs 37, 46, 81
Fontek PostScript font icon 98
font families 109-110
fonts
Apple classic fonts 107
bitmapped 97, 99-100, 106
corrupted, resolving installation
problems 66-69
displaying in the Fonts menu 106
downloadable 108
Geneva appears as a substitute
font 107
how the Macintosh looks for 101
installing 14
list of 109-110
low memory and 107
making purchasing decisions 106
naming 100
organizing in suitcases 103-104
PostScript 98, 100, 106
QuickDraw GX 98
search order 101
storing on the computer 102-104
stylesfor 105
supported by the printer 90, 95,
109-110
TrueType 96-97, 99-100, 106
used for display 106
viewing on-screen 96-97
Fonts folder 102, 106
removing items from 67
Fonts menu 106
font styles 105
font substitution 107, 108
font suitcases 102-104
four-color ink cartridge. See color ink
cartridge
future print time, setting 43

G

Get Info command 78
glossy paper 26, 50, 82, 120
guide. See paper guide

H

halftoning method, selecting 32, 38,
52,121
hardware requirements x

high-performance black ink cartridge. See

black ink cartridge
holding a print request, background
printing and 43
horizontal orientation. See
landscape orientation
horizontal white lines appear on
the printed page,
troubleshooting 84
humidity range for the printer 92

icons
bitmapped font 97

Color StyleWriter 2500 16, 17, 31, 66

Color SW 2500-Troubleshooting
file 19

default desktop printer 38, 40

desktop printer 16, 31, 40, 71, 127

disabled (X) desktop printer 40,
71, 127

document 31

envelope 24, 25

modem port 11, 18

paper 24, 25

PostScript font manufacturers 98

printer error 40

printer port 11, 18

printing 40

stopped print queue 40

image print option
low memory and 78
selecting 30, 119, 121



ink

checking if the printer is out of ink 76

reducing the amount used 53
smears when rubbed,
troubleshooting 83
ink cartridges
extending the life of 88
installing 7-10
part numbersfor 93
preventing from drying out 4, 6, 62
replacing 58-61
storing 4, 62
switching 53
troubleshooting 76
unpacking 3
ink cartridge storage case 3, 4, 62
ink tanks
extending the life of 88
part numbersfor 93
replacing 55-57
safety instructions for 66
troubleshooting 76
ink waste container 77
inserting paper into the sheet feeder. See
loading the sheet feeder
installation problems, troubleshooting
6669
Installer dialog box 15, 68, 126
Installer program 14-16, 6869,
125-127
installing
fonts 14
ink cartridges 7-10
printer software 14-16, 6869
QuickDraw GX software 14
interface specifications of the printer 90
interference with television and radio
reception Vi
internal modem on PowerBook
computers 11, 17, 18, 70
internal paper selector lever 12, 25, 87

jagged edges on printed output 96, 97
jammed or damaged paper, removing
73,75

K
Key Caps desk accessory 97

L

labels 26
landscape orientation
low memory and 78
setting 29, 117, 118
layout, adjusting 29
Layout pop-up menu (Page Setup dialog
box) 37
legal-size paper 13, 25
letterhead paper 24
letter-size paper 13, 27-28
lights on the printer 6, 21, 72
liquid cleaners 63
liquid spillsin the printer 2
loading the sheet feeder
with back-print film or transparencies
26, 51, 75
basic instructions 12-13, 24-25
with envelopes 24, 26, 75
with labels 2, 26
with various kinds of paper 26, 49-50
LocalTalk cable 11
Local Tak network, connecting the
printer to 48
location for the printer, choosing 4
locking disks 14
log file for printer usage 46

Index
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Index

M

maintenance tasks. See also safety
instructions
cleaning the printer 2, 63, 87
replacing ink tanks 55-57
replacing the ink cartridge 58-61
storing a second ink cartridge 62
Matching Method pop-up menu (Color
Options dialog box) 33
memory
low memory indications and
suggestions 78-79
required for the printer x
virtual memory 4, 79
messages on-screen 70, 77
mini pages (2 or 4), printing 29, 37
modem port 11, 17, 18
moi sture exposure to the printer 2
monitoring and controlling print requests
with background printing on 42—43
on anetwork printer 47
without desktop printers 128
Monitors control panel 113
moving a desktop printer icon 40
moving a print request to another printer,
background printing and 43
moving the printer along distance
129-130
multipart forms 49, 82

N

naming
fonts 100
font suitcases 104
network cable 11
networks
AppleTalk 44-46
LocalTak or EtherTalk 48
network zones 47, 116
non-standard documents, printing 28-31

Normal print quality option 30, 53,
119, 120

notification of print completion,
selecting 30

nozzle test pattern, interpreting 22, 86

number of copiesto print, selecting 30

0

opening the printer 7, 25, 56, 59, 87
operating environment specifications 92
orientation

low memory and 78

setting 29, 117, 118
output tray, opening 13, 25

P

packing the printer 129-130
page breaks, change unexpectedly,
troubleshooting 80
Page Setup command (File menu) 19,
23, 29, 34-37, 117-118
Page Setup dialog box 19, 29, 37,
80, 117
expanded QuickDraw GX
version 118
page setup options. See also print options
setting 23, 29, 34-35, 37, 117-118
page size, adjusting 29, 117
pages to print, selecting 30
paper. See also print materials
jammed or feeding improperly 73-75
loading into the sheet feeder 12-13,
24-25, 75
saving 37
sizes supported 91
types not to use 49, 82
typesto use 26, 49-50, 77, 82, 90
paper guide, adjusting 13, 24, 75
paper icon 24, 25
paper-matching feature, QuickDraw
GX 120



paper selector lever
external 13, 24
internal 25, 87
paper support, extending 13, 24
paper type, indicating 30, 77, 118,
119, 121
part numberslist 93-94
password for network printer usage
45, 47
Pattern halftoning option 32, 38, 83
PICT/PICT2 formeat files, watermarks
and 36, 81
pictures do not print, troubleshooting 80
pixels 96
plain paper
tipsfor using 49
troubleshooting 82, 83
weight recommended 26, 49, 90
platen, cleaning 63, 87
plugging in the printer 5
portrait orientation
low memory and 78
printing in 27
setting 29, 117, 118
ports
changing the selection 70
modem and printer 11, 17, 18
serial, PowerBook computers 18
PostScript fonts
described 98
downloadable 108
TrueTypeand 100, 106
PostScript page description language 79,
80, 98
power adapter 3, 92
PowerBook computers
internal modemsand 11, 17, 18, 70
selecting the correct system profile for
ColorSync 32, 121
power button 6, 21, 72
power consumption specifications 92
power light 6, 21, 72

Power Macintosh computers, virtual
memory and 4
power requirements for AC power
adapter 92
power-saving feature 6
power strip, turning off 6
precautions. See maintenance tasks;
safety instructions
premium coated/premium plus coated
paper 26, 50, 90
printable area 91
Print command (File menu) 20, 27-28,
30-33, 38, 119-122
Print dialog box 20, 30, 52, 85, 119
expanded QuickDraw GX version
120-122
printer error icon 40
printer log file 46
printer port 11, 17, 18
Printer Profile pop-up menu (Color
Options dialog box) 33
printer software
installing 14-16, 6869
removing 125-127
print head
cleaning 30, 84-85, 122
handling of 8-9, 59
preventing from drying out 4, 6, 62
troubleshooting 83, 84, 86
printing. See also background printing;
desktop printing;
troubleshooting
adjusting color options 30, 32—-33
back-print film 26, 51, 75, 81, 120
borders around mini pages 29, 37
color printing quirks 33
the Color SW 2500-Troubleshooting
file 19-20
envelopes 24, 25, 26, 27, 74-75
labels 26
in landscape orientation 29, 117
legal-size paper 13, 25
letterhead paper 24
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mini pages (2 or 4) 29, 37
non-standard documents 28-31
on ashared printer 47
on various paper finishes 26
in portrait orientation 27-28, 29, 117
previously formatted documents 31
with QuickDraw GX 115-122
reducing cost of 53
scaled documents 29, 34, 117, 118
selected pages of adocument 30
several documents at once 31
specific number of copies 30
standard documents 27-28
atest page 19-20, 56, 59, 84, 86
three-hole punched paper 24
transparencies 26, 51, 75, 120
troubleshooting 69-88
U.S. letter-size paper 27-28
utilitiesfor 30
watermark images 29, 34-37
while using your computer 41-43
without leaving the Finder 31
printing icon 40
Printing menu, Set Default Printer
command 39
Printing Prefsfolder 37, 46, 81
print materials. See also back-print film;
envelopes; paper; transparencies
part numbersfor 93
standard and non-standard, printing
27-31
tipsfor choosing 49-51
typesto use 24, 26, 90-91
PrintMonitor command (Application
menu) 128
PrintMonitor dialog box 128
PrintMonitor program
changes to printing software and x
using if you don’'t have desktop
printers 128
print nozzles, checking 21-22
print options. See also page setup options
setting 30, 3233, 39, 119-122

print quality
for greater speed 53
QuickDraw GX printing and 119,
120, 121
selecting 30, 52
troubleshooting 82-87
print queue
removing requests from 79
working with 42-43
print requests
deleting multiple requests for a
document 70
monitoring and controlling 42—43,
47,128
removing 79, 128
scheduling 120, 128
print time, setting, background printing
and 43
profiles, ColorSync 32, 112, 113, 121
proportional space numerals 106

Q

quality options. See print quality
QuickDraw GX
background printing and 41
cleaning the print head 122
expanded Page Setup dialog box 118
expanded Print dialog box 120-122
font features 98
installing 14
network printing and 44, 70
page setup definition 117-118
printing with 119-122
setting up the printer for use with
115117
turning off 123
typographic features of 106
Quit command (File menu) 20



R

radio and television reception,
interference with vi
RAM. See memory
Read Mefile 32
reducing the printed image. See scaling
removing
desktop printing software 125-127
jammed or damaged paper 73, 75
renaming
a desktop printer icon 40
anetwork printer 48
repacking the printer 129-130
replacing
theink cartridge 5861
ink tanks 55-57
resetting the printer 71
resolution
of bitmapped fonts 7
specifications of the printer 89
Restart command (Special menu) 14
restarting the computer with extensions
turned off 14
RGB color system 111
rollers, cleaning 63, 87
rotated text, troubleshooting 79

S

safety instructions 1-2, 6, 66. See also
maintenance tasks
Save command (File menu) 33
saving
energy 6
paper 37
scalable fonts 96, 97, 100
scaling
adjusting 29, 34, 117, 118
of watermarks 35, 36
Scatter halftoning option 32, 38, 52
screen fonts 97
seria cable 11

seria port on PowerBook computers 18
Set Default Printer command (Printing
menu) 39
Setup dialog box 45
shared printers
cleaning the print head and 85
print requeststo 42
setting up 4448
troubleshooting 70, 79
user instructions for 47
sheet feeder
capacity of 12, 26, 74, 90
loading 12-13, 24-26, 49-51
troubleshooting 7375
unpacking 3
size of printer 91
software disks, unpacking 3
software requirements x
sorting items waiting to print,
background printing and 43
Special menu, Restart command 14
speed of printing, increasing 53
stains on printed pages,
troubleshooting 87
standard documents, printing 27—28
stapled paper 49
stopped print queueicon 40
stopping items temporarily from printing,
background printing and 43
storage case for ink cartridge 3, 4, 62
storage environment specifications 92
Stretch to Fit watermark scaling option
35, 36
stripes appear on the printed page,
troubleshooting 84
stylesfor fonts 105
suitcases for fonts 102-104
swash characters 106
switching between printers 38-39
system profile, ColorSync and 32, 112,
113,121
system requirements x
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technical specifications of the printer
89-91
television and radio reception,
interference with vi
temperature range for the printer 92
test page, printing 19-20, 56, 59, 84, 86
test pattern for print nozzles, interpreting
22, 86
three-hole punched paper 24
throwing away a desktop printer icon 40
transparencies
loading into the sheet feeder 26, 51,
75
print quality setting for 120
tipsfor using 51
troubleshooting
cable connections 70
color printing quirks 33
colorsdon’t look right 84
colors skip or streak at the bottom of
the page 82
Color SW 2500 icon doesn’t appear in
the Chooser 66
columns are misaligned when
printed 81
computer crashes while attempting to
print 69
corrupted fonts 6669
deleting multiple print requests 70
error light indicates a problem 72
horizontal white lines appear on the
printed page 84
ink cartridges and tanks run out of ink
too quickly 76, 88
ink smears when rubbed 83
installation is unsuccessful 66—69
jagged text 79
lines fade or break up 83
low memory indications and
suggestions 78-79

message states that no Color
StyleWriter 2500 is connected
70-71
nothing prints 70-71, 76
nozzlesin print head 83, 84, 86
page breaks change unexpectedly 80
paper is jammed or feeds improperly
73-75
a particular document won't print 76
pictures do not print 80
port selection 70
PowerBook computers 70, 71
power light indicates a problem 72
printer seemsslow 73
printer software installation 16, 70
printing appears on only part of the
paper 84
printing is backwards 81
printing is off center 80
printing is smeared, blurred, or
smudged 83
printing istoo light or too dark 83
print quality 82-87
resetting the printer 71
rotated text printsjagged 79
shared printers 70, 79
stains on printed pages 87
stripes appear on the printed page 84
text printsin Genevafont 79
watermark problems 81
wavy or distorted print output 87
TrueType fonts
bitmapped fonts and 99-100, 106
described 96-97
downloadable 108
PostScript fonts and 100, 106
Turn Desktop Printing Off (Apple menu)
123
turning the printer on and off 6



U

unpacking the printer 34

unplugging the printer 2, 5, 6, 63, 66

urgent print requests, background
printing and 43

U.S. letter-size paper 13, 2728

Utilities dialog box 85

utilities options to clean the print head

30, 85, 122

vV

vertical orientation. See portrait
orientation

virtual memory
low memory condition and 79
Power Macintosh usersand 4
visual aert of print completion 30

W, X, Y

warranty on the printer 55, 65
waste ink container 77
Watermark Options dialog box 35
watermarks
creating your own 36-37
low memory and 78
scaling 35, 36
specifying 29, 34-35
troubleshooting 81
wavy print output, troubleshooting 87
weight of printer 91
weight recommended for paper 26, 49,
82, 90
white lines appear on the printed page,
troubleshooting 84
wrinkled paper 49

Z

zones, network 47, 116

Index

141



Apple Computer, Inc.

1 Infinite Loop

Cupertino, California 95014-2084 030-8133-A
408.996.1010 Printed in U.S.A.



